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“On the Internet, there is no there.”

—Anna Paquin, MCI Commercial
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In this chapter, you will
learn how to:

■ List and define the six things
you must have in order to
connect to the Internet.

■ Use a Web browser to go surfing
on the Internet, bookmark
important sites, and share
bookmarked favorites with
coworkers.

■ Download and install multimedia
plug-ins and viewers that are not
built into the browser.

■ Configure the browser’s
advanced security settings to
help guard against malicious
code such as viruses, worms,
and Trojans that can be harmful
to your computer.

■ Use the appropriate search
engine to conduct subject-
oriented as well as full-text
searches by keyword or
concept, including multimedia
searches that can find pictures,
audio, and video as well as text.

■ Download found objects from
the Internet and define the types
of files that are commonly found.

EV E R Y O N E reading this book has most likely been on the
Internet. You have probably surfed the Web, for example, and you may
consider yourself pretty good at surfing. But do you understand the theory
of surfing well enough to truly glide across the Net and find things
quickly? Do you know the proper way to download and handle the differ-
ent kinds of resources you can find on the Internet? Are you sure you know
the most cost-effective way to connect to the Internet? Do you know the
best way to configure your security settings to safeguard against viruses,
worms, Trojans, and other kinds of Internet attacks?

So you can get more out of the Internet, this part of the book helps you
understand how best to connect and surf the Net safely, productively, and
cost effectively. To get the most out of your online experience, you learn
how to download and configure the latest multimedia plug-ins. Then you
will be ready to use the search engines not only to find but also to play the
multimedia objects of your desire. Before you can do any of these things,
however, you need to learn about getting connected, so that is where this
chapter begins.

Getting Connected

To get connected to the Internet, you need the following six things:

� Internet-Ready Computer A computer is Internet ready if it has
the physical hardware needed to connect to the Internet, such as a
modem or a network interface card.

� Operating System Most computers come with an operating system
preinstalled. The most popular operating systems are Microsoft
Windows, the Macintosh OS, UNIX, and Linux.

� TCP/IP In Chapter 1, you learned that computers communicate
with the Internet through a protocol suite called TCP/IP. To get on
the Internet, therefore, the computer must have TCP/IP installed.

� Client Software Client software is the application program you
run when you access services on the Internet. The most popular
examples of Internet clients include programs that let you read
your e-mail, browse the Web, and IM (i.e., instant message) your
friends and colleagues.



� Internet Connection The connection from your computer to the
Internet is called your Internet connection. The next part of this
chapter covers different ways of creating this physical connection
to the Internet.

� Internet Address To go somewhere on the Internet, you need to
know the destination address of the service or resource you are
planning to access. This destination could be the address of a Web
site, the e-mail address of a person to whom you are sending a
message, or the FTP address of a server from which you want to
download a file.

Internet Service Providers

Most users get their Internet connection from an Internet Service Pro-
vider (ISP). An ISP is a networking company that connects you to the
Internet and provides you with Internet services, including access to the
World Wide Web, e-mail, listserv, chat, and newsgroups.

In the past, some ISPs charged an hourly fee. If you use the Internet a lot,
however, paying by the hour can be very expensive. Listed here are four of
the most popular ISPs, all of which provide unlimited dialup usage for a
flat fee of about $24 per month.

America Online

America Online, also known as AOL, is the largest Internet Service Pro-
vider. The number of AOL subscribers has skyrocketed to 32 million users.
Each user gets up to seven e-mail accounts and an allotment of 2MB of per-
sonal Web space for each account. AOL uses a channel-style of presenta-
tion to make it easy to navigate its many offerings. A huge amount of AOL
content is not otherwise available on the Internet. Parental controls enable
parents to limit access to adult content. To find out more about AOL, go to
www.aol.com.

AT&T WorldNet

AT&T WorldNet Service provides fast, reliable Internet access nation-
wide. You get six e-mail accounts, each of which has 10MB of personal
Web space. For more information about AT&T WorldNet Service, go to
www.att.net.

Microsoft Network

The Microsoft Network (MSN) provides up to nine e-mail accounts, the
MSN Messenger service for talking with your friends online, and up to
30MB of space for your photos and personal Web pages. To find out more
about the Microsoft Network, go to www.msn.com.
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EarthLink

In 2000, EarthLink merged with Mindspring to become the nation’s second-
largest ISP (Bloomberg News, 2000). Its partnership with the Snap!
Portal provides EarthLink users with an intuitive user interface. Every
user gets an allotment of Web space with a personal start page including
an e-mail indicator, a search engine, headline news, stock quotes,
weather, and personal reminders. You can find EarthLink on the Web at
www.earthlink.net.

Regional and Local Networks

By looking up “Internet Services” in the yellow pages of your telephone di-
rectory, you will probably find some regional and local ISPs listed in addi-
tion to the nationwide service providers discussed so far. For example, a
regional ISP called Starpower offers Internet services in Washington, DC,
northern Virginia, and Maryland. Starpower can also provide telephone
and cable TV services. To contact Starpower, go to www.starpower.net.

An excellent source for finding out about other ISPs in your area is on
the Web at thelist.internet.com.

School and College Networks

Schools and colleges commonly operate computer networks that provide
Internet services for free to their faculty, staff, and students. If you are
lucky enough to belong to such a user community, your local school or col-
lege serves as your ISP. Because these services are free, however, the re-
sources are sometimes inadequate to meet the demand, and it is not
uncommon for members of school and college networks to also subscribe
to one of the commercial ISPs. Some campuses have even negotiated deals
with commercial ISPs to get a lower price for individuals to subscribe to
the commercial service.

User Satisfaction

Consumer Reports magazine rates ISPs in terms of customer satisfaction. In
a survey of 1,640 dialup modem users, for example, AT&T WorldNet,
BellSouth, and EarthLink were highly rated. AOL and MSN users, on the
other hand, reported problems with interruptions during dialup sessions.
Both AOL and MSN have pledged to work to correct these problems. For
the latest rankings of Internet service providers, go to consumersearch.com/
www/computers/internet_service_providers.

Transport Medium

The transport medium is the physical connection over which information
travels on the Internet. Very high-speed transmission lines carry the back-
bone of the Internet across the country and over the world. Most often these
backbone lines are fiber-optic cables or copper transmission lines. The ma-
jor ISPs have very high-speed connections to the Internet’s backbone.



The physical connection between your computer and your ISP is often
the most critical part of the transport medium, because it determines the
bandwidth of your connection to the Net. Most Internet connections use
wires or cables you can see and touch. It is also possible to use wireless con-
nections such as cell phones and satellites that communicate via radio sig-
nals. Depending on the medium you choose, you need to have specific
hardware installed in your computer to handle the communication.

Telephone Modems

The most common means of connecting to the Internet from home is via plain
old telephone service, also known as POTS. To communicate with the
Internet over an ordinary telephone line, your computer must have a modem.
The term modem is a combination of the terms modulate and demodulate,
which describe how your computer sends and receives digital information
over analog phone lines. Modems are so popular that most computers being
sold today come with modems built in. Other models require the addition of
external modems that connect to your computer’s serial port or modem cards
that plug into one of your computer’s expansion slots. Figure 2-1 contains a
block diagram that describes how modems work.

Modems have gotten steadily faster as computer technology has ad-
vanced. Modem speed is important because it determines how long you
have to wait for information to arrive. Modem speed is often expressed in
units known as bits per second (bps) or kilobits per second (Kbps). A
kilobit is a thousand bits. Common speeds are 14,400 bps (14.4 Kbps),
28,800 bps (28.8 Kbps), 33,600 bps (33.6 Kbps), and 56,000 bps (56
Kbps). For example, information traveling at 14,400 bps takes twice as
long to arrive as it would at 28,800 bps.

Just because you have a superfast modem, such as 56 Kbps, does not
necessarily mean information actually travels that fast to and from your
computer. The telephone lines and the equipment (routers and switches)
the lines pass through on their way to your ISP may preclude your
superfast modem from using its highest speed. Many modems have built-
in compression and decompression fea-
tures that enable them to pack informa-
tion more tightly in the communication
packets, thereby achieving an actual
transmission rate higher than their ad-
vertised data rate. This feature only
works, however, for data that have not
already been compressed.

As data communications technology
continues to advance, modems will
continue to increase in speed. Someday,
the so-called high speeds discussed in
this book will seem slow.
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FIGURE 2-1 Follow the signal to see how modems work by modulating the computer’s
digital signal into an analog signal that can be transmitted over plain old

telephone service (POTS) to your ISP, where the signal is demodulated into a digital signal. �



PPP vs. SLIP

The two most popular protocols for telephone modems are Point to Point
Protocol (PPP) and Serial Line Internet Protocol (SLIP). True to its
name, SLIP handles the Internet Protocol only. PPP, which is the more
modern of the two, supports not only TCP/IP but also NetBEUI and IPX/
SPX, which are communication protocols you will study in the network-
ing part of this book. SLIP has faded in popularity due to the superiority of
PPP, which has better error checking and supports user ID and password
authentication. Another reason PPP has become the telephone modem
protocol of choice is that PPP can assign IP addresses automatically,
whereas SLIP requires a preassigned IP address. PPP is built in to the Win-
dows XP operating system, which uses PPP when modem users dial up to
the Internet.

Ethernet

The invention of Ethernet (pronounced ee-thur-net) in Bob Metcalfe’s
Harvard Ph.D. thesis in 1973 was a data communications breakthrough
that fueled the explosion of local area networks (LANs) throughout aca-
demia and industry. Ethernet networks transmit data at high speed, typi-
cally up to 10 megabits per second (Mbps). (Mega means a million, so 10
megabits means 10 million bits.) At Ethernet speeds, a file that takes 10
minutes to transmit over a 14.4 Kbps modem arrives in just 1 second. Ac-
tual downloading times may vary, depending on compression schemes,
network traffic, and the number of users sharing the Ethernet.

If you work at a school or company that has its PCs connected to the
Internet at high speeds, chances are the communications medium is an
Ethernet. At first, Ethernet required the use of coaxial cable, the kind of
wire used in cable TV. Now there is a so-called 10BaseT Ethernet that can
use Category 5 twisted-pair telephone wiring. A faster 10/100BaseT
Ethernet can move data at rates up to 100 megabits per second. There is
also a 10 gigabit Ethernet standard known as 10GbE. Officially ratified in
the summer of 2002, the 10GbE standard uses fiber optics to push Ether-
net into speeds ranging up 10 gigabits per second (Gbps). The prefix giga
means billion; a gigabit is one billion bits and 10 Gbps is therefore 10 bil-
lion bits per second.

ISDN

ISDN stands for Integrated Services Digital Network. It is the digital tele-
phone system the regional Bell companies are installing in most of the
United States; when this book went to press, about 80 percent of the coun-
try could get ISDN.

ISDN signals are carried over two or more 64-Kbps (64,000 bits per
second) circuit-switched channels to carry voice and data and a lower-
speed packet-switched channel that carries control signals. The Basic Rate
Interface (BRI) service of ISDN is 144 Kbps, made up of two 64-Kbps data
channels and one 16-Kbps control channel. A special version of PPP called
multilink PPP combines the two 64-Kbps data channels to create an effec-
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tive data rate of 128 Kbps. The Primary Rate Interface (PRI) service uses
23 data channels and a 64-Kbps control channel to boost the data rate to
1,544 Kbps (1.544 Mbps), which is capable of real-time videoconferencing
in addition to more traditional data services.

To use ISDN to connect to the Internet, you need to contact both your
local telephone company and your Internet Service Provider to find out
whether ISDN is available in your area and to make sure your ISP supports
it. ISDN lines cost more than ordinary phone lines, so be prepared to pay
more for the higher data rate.

Cable Modems

A cable modem is a network adapter used to connect PCs to TV cables in
neighborhoods where cable TV companies offer Internet services over TV
cables. Cable modems are potentially faster than telephone modems be-
cause TV cables, being coaxial, are capable of carrying high-speed Ether-
net signals in addition to conventional television signals. The term
broadband is used to refer to this type of connection that carries multiple
channels of information over a single cable.

To find out if cable modems are available in your neighborhood, follow
this book’s Web site link to the cable modem Zip code search.

DSL, SDSL, and ADSL

DSL stands for Digital Subscriber Line, which is a broadband method of
connecting to the Internet over existing telephone lines. There are two
kinds of DSL: synchronous and asynchronous. Synchronous DSL (SDSL)
supports the same high-speed data rate for both upstream and down-
stream traffic. Asynchronous DSL (ADSL) lowers the cost of DSL connec-
tions by using a high-speed data rate for downloads but a slower rate for
uploads. Download speeds range from 384 Kbps to 8 Mbps, and upload
speeds range from 128 Kbps to 1 Mbps. The faster the speed, the higher
the cost.

The typical home user spends a lot more time downloading than up-
loading. When you click to play a movie, for example, very little informa-
tion goes up from your computer to the movie site to trigger the playing of
the movie. When the movie comes down to your PC, on the other hand, the
amount of bandwidth required is huge. ADSL models itself after this trend
of home users downloading much more information than they upload.
Another advantage of ADSL is that you can use the same telephone line for
voice as well as data transmissions. SDSL, on the other hand, cannot oper-
ate simultaneously with voice transmissions on the same wire.

When this book went to press, DSL was available in about 75 percent of
the United States. To find out whether you can get DSL at your home or
business, follow this book’s Web site link to the DSL area code search and
use the menus to find out if access is available in your locale, and how
much it costs to connect at different speeds. Be prepared to see some pretty
high prices for the faster speeds.

To learn more about DSL and compare the relative merits of SDSL and
ADSL, follow the link to the DSL Resource Center.

Chapter 2: Surfing and Searching the Internet



Satellite

Where cable or DSL is not available, satellite Internet service is an attrac-
tive alternative in areas that have a clear view of the southern sky. Like
ADSL, satellite Internet service has a faster download than upload speed.
Typical transmission speeds are 500 Kbps downstream and 150 Kbps up-
stream. In extremely bad weather, the speeds can decline due to the ob-
structed view. Whereas most DSL vendors permit subscribers to connect
more than one computer, satellite providers normally restrict usage to a
single computer per subscription. To learn more, follow this book’s Web
site links to satellite Internet providers.

Comparing the Ways to Connect

To summarize the many alternatives presented in this chapter, Table 2-1
compares the different ways to connect to the Internet. By studying this
comparison, you should be able to select an option that suits your needs
and budget.

To test the bandwidth your connection actually provides, follow this
book’s Web site link to the bandwidth meter.

Prepaid Internet Cards

Computer users who travel may be interested in prepaid Internet calling
cards. Manufactured by Sprint and AT&T, the prepaid Internet cards let
you purchase a number of hours of Internet connection time in advance of
using it.

Internet Technologies at Work

Transport Medium Time to Download
100KB Picture

Time to Download
900KB Audio

Time to Download
10MB Movie

Estimated Monthly
Communications Cost

14.4 Kbps modem 55 seconds 500 seconds 93 minutes $23

28.8 Kbps modem 28 seconds 250 seconds 46 minutes $23

33.6 Kbps modem 24 seconds 214 seconds 40 minutes $23

56 Kbps modem 14 seconds 128 seconds 24 minutes $23

128 Kbps ISDN 6 seconds 56 seconds 10 minutes $35

256 Kbps DSL 3 seconds 28 seconds 5 minutes $129

500 Kbps satellite
downstream, 159 Kbps
upstream

1.6 seconds 14.4 seconds 2.6 minutes $70

1.5 Mbps DSL 0.54 seconds 4.8 seconds 54 seconds $309

1.5 Mbps ADSL
downstream, 128 Kbps
upstream

0.54 seconds 4.8 seconds 54 seconds $49

3 Mbps cable modem 0.27 seconds 2.4 seconds 27 seconds $35-50

Note: Cable modem speeds vary depending on the number of simultaneous users of the local cable network.

TABLE 2-1 Internet Connection Comparison Matrix �



The prepaid Internet card may also be of interest to people who seldom
connect to the Internet and wish to avoid paying a regular monthly fee.
The prepaid Internet market is expected to grow from $10 million in 2001
to $280 million in 2005. To learn more, follow this book’s Web site links to
prepaid Internet cards.

Direct Connections

An Internet connection that is always on is called a direct connection.
To use the Internet over a direct connection, you simply begin using the
client software with which you wish to access the Internet. Of the vari-
ous ways this chapter has presented for connecting to the Internet, the
following provide you with a direct connection:

� Ethernet

� ISDN

� Cable modem

� DSL

� Satellite

Connections that are not direct, on the other hand, require you to do
something special to get connected. To use a dialup connection, for exam-
ple, you must dial up to your ISP to get connected.

Sometimes even a direct connection can stop working. When hurricane
Isabel hit the mid-Atlantic United States, for example, my ISDN line was
out of service for several days. To work online in the meantime, I used a
modem to dial up, which enabled business to continue, albeit at a lower
speed. Many users with direct connections keep a prepaid Internet card on
hand for emergency use during such outages.

Chapter 2: Surfing and Searching the Internet

Comparing the Ways to Connect
As you have learned so far in this chapter, there are many ways to connect to the Internet. Keeping them
straight in your own mind is important if you want to advise people regarding the appropriate way to connect
to the Internet in their particular circumstances. See if you can match the ways of connecting on the left with
their operational descriptions on the right.

____ telephone modem A. Broadband coaxial connection that carries high-speed Ethernet signals as well as conventional
television

____ Ethernet B. Typical transmission speeds are 550 Kbps downstream and 150 Kbps upstream

____ ISDN C. Broadband method of connecting to the Internet over existing telephone lines

____ cable modem D. Basic service is 144 Kbps, made up of two 64-Kbps data channels and one 16-Kbps control channel

____ DSL E. Operates over category 5 twisted-pair telephone wiring at speeds up to 10 Mbps

____ satellite F. Modulates the computer’s digital signal into an analog signal that can be transmitted over POTS

Cross
Check



Browsing the Web

Most of the people reading this book have probably already had their first
surfing experience. Many may consider themselves adept at surfing, and
some could even be addicted to it.

Whether or not you have surfed the Net, studying the concepts in this
chapter will enable you to become a better surfer than if you “just do it.” If
you have become addicted, the techniques you learn here will help you
gain control over the Net instead of allowing it to control you.

In telecommunications, the term surf means to browse by going from
place to place in search of something that interests you. On TV, you surf by
changing channels continually until you find a program you want to
watch; this is known as channel surfing. On the Net, surfing means to use a
program called a browser to go from site to site in search of information
that interests you.

The most popular place to surf on the Internet is the World Wide Web.
As you learned in Chapter 1, the Web is a worldwide hypertext system that
interconnects millions of documents. The connections are made through
links, which can be textual or graphical. A link is a hot spot that, when se-
lected, triggers the object of the link. You select the link by clicking on the
word or picture that triggers it. Progressively clicking through the Web by
triggering the links that interest you is known as browsing, a term synony-
mous with surfing the Net.

What Is a Browser?

The program you run when you surf the Web is called a browser. Because
you surf the Web to receive content, the browser is an example of client
software. As this chapter proceeds, you will learn how to use a browser not
only to surf Web pages but also to search for and download pictures, au-
dio, and video content. You will learn how to configure the browser to dis-
play multimedia content by using the plug-in of your choice. To keep your
computer safe, you will also learn how to configure the browser’s security
settings to protect your computer from Internet attacks.

Selecting a Web Browser

Microsoft makes the most popular browser, called Internet Explorer (IE).
More than 90 percent of Internet users browse the Web with Internet Ex-
plorer. It is an excellent choice for computers that run the Windows oper-
ating system. Internet Explorer comes in both desktop and handheld
versions. The handheld version is called Pocket Internet Explorer and runs
under Windows CE on the Pocket PC family of handheld computers.
Internet Explorer is preinstalled on most computers sold today. Users
who do not have Internet Explorer can download it freely from
www.microsoft.com/windows/ie, where the latest updates are also available.
If you have trouble downloading the browser, ask your Internet Service Pro-
vider to help you get a setup disk that will install the browser for you.

Internet Technologies at Work



On the Macintosh, an important Web browser change occurred in
2003. Before then, the default browser was the Macintosh version of
Internet Explorer. In 2003, however, Microsoft announced that it was dis-
continuing work on the Macintosh version of IE. Apple now produces its
own Web browser, which is called Safari and ships on every Macintosh as
the default Web browser. Macintosh users can download the latest version
or get updates at www.apple.com/safari. To run Safari, Macintosh users
need to be running the Mac OS X operating system.

Another popular Web browser is Netscape Navigator. In 2003, how-
ever, Netscape’s parent company, America Online, officially stopped all
work on the Netscape Navigator product. Work continues on an open
source version called Mozilla. The term open source refers to software for
which the source code is available to the general public free of charge. Any-
one can download the source code, use it freely, and make enhancements.
People who make enhancements to Mozilla can submit them to the
Mozilla Foundation, which maintains the official master copy of the
Mozilla software. You can download the Windows, Linux, or Macintosh
version of Mozilla from www.mozilla.org.

Legacy Browsers

In computing, the term legacy refers to something old. The term legacy
browser refers to old versions of Web browsers. You need to be aware that
some people have not upgraded to the latest version and are using a legacy
browser. Some Web page elements may display differently or may not
work at all in the older browsers. In Chapter 8, for example, you learn how
cascading style sheets (CSS) provide you with some powerful new ways of
formatting and laying out Web pages. Legacy browsers, however, do not
support all the CSS features. Web pages that use CSS, therefore, may dis-
play differently, depending on the age of the browser. Internet Explorer did
not support style sheets prior to version 3, and Netscape began supporting
CSS with version 4. Chapter 8 provides you with a link to a chart that
shows which CSS features are sup-
ported in which versions of the leg-
acy browsers.

The legacy browsers you will
encounter most often are the ear-
lier versions of Internet Explorer
and Netscape Navigator. Table 2-2
compares the features they sup-
port. The Web authoring tutorial
in Part II of this book shows you
how to create Web pages using all
these features. In my opinion, us-
ers who have legacy browsers
should upgrade to the latest ver-
sions rather than expect Web de-
velopers to shy away from the
newer features.
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Update Your Browser
To make sure you have the latest version of your Web browser, you
should go to the download site for the brand of Web browser you are
using primarily on your computer. Check to see if a new version of your
browser is available. If so, follow the onscreen instructions to down-
load and install the update. Here are the sites to check:

� To update Internet Explorer, go to www.microsoft.com/
windows/ie.

� To update Netscape, go to www.netscape.com.

� To update Mozilla, go to www.mozilla.org.

� To update Safari, go to www.apple.com/safari.

Try This!



Understanding URLs

Every place you can go on the Web has a global address known as a Uni-
form Resource Locator (URL). Most often the resources are hypertext
documents, but they can also be pictures, sounds, movies, animations, or
application software. URLs can also bring up newsgroups, chat rooms,
search engines, and real-time audio and video streams.

Elements of a URL

A URL can have several parts, which always appear in this order:

� Protocol

� Server name

� Port number (optional)

� Path/filename (optional)

� Anchor (optional)

Here is what the different parts of a URL mean:

Internet Technologies at Work

Browser Frames Inline
Frames

Plug-Ins JavaScript Style
Sheets

Dynamic
HTML

XML

IE 6.0 Yes Yes Yes Yes Yes Yes Yes

IE 5.5 Yes Yes Yes Yes Yes Yes Yes

IE 5.0 Yes Yes Yes Yes Yes Yes Some

IE 4.0 Yes Yes Yes Yes Yes Yes No

IE 3.0 Yes Yes Yes Yes Yes No No

IE 2.0 No No No No No No No

IE 1.0 No No No No No No No

Netscape 7.0 Yes Yes Yes Yes Yes Yes Yes

Netscape 6.1 Yes Yes Yes Yes Yes Yes Yes

Netscape 6.0 Yes Yes Yes Yes Yes Yes Yes

Navigator 4.7 Yes No Yes Yes Yes Yes No

Navigator 4.5 Yes No Yes Yes Yes Yes No

Navigator 3.0 Yes No Yes Yes No No No

Navigator 2.0 Yes No Yes Some No No No

Navigator 1.1 No No No No No No No

TABLE 2-2 Windows Legacy Browser Comparison Chart �

protocol Protocols include HTTP, FTP, mailto, and news; the Web’s protocol is HTTP, which stands for hypertext transfer protocol.

server name The server name is the Internet address of the computer or file server on which the resource resides.

port number Port numbers rarely appear in URLs, because almost every file server is on the Web’s default port, which is port 80.
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The following analysis shows how the various parts of a URL get com-
bined into a specific address on the World Wide Web. This example is the
URL for the professional experience section of my résumé.

http://www.udel.edu/fth/resume.html#professional

Web Sites

Every hypertext document on the World Wide Web resides on one of the
computers connected to the network. The place where the hypertext docu-
ment is stored on that computer is known as its Web site. Every Web site
has a URL.

For example, Sony’s Web site is http://www.sony.com. CNN’s Web site
is http://www.cnn.com. Netscape is at http://www.netscape.com.
Microsoft is at http://www.microsoft.com. Do you notice the similarity in
these corporate Web site addresses? Almost every company in the world
has a Web site address in the form of http://www.company_name.com.

HTTP is the default protocol for Web pages. It is not necessary to type
http:// because the browser assumes this is the protocol and inserts it auto-
matically. Typing www.cnn.com takes you to the same place as typing
http://www.cnn.com, for example. You need to type the protocol only if it
is not HTTP.

Web Pages

Like books, each site on the Web consists of one or more pages. Each page
at a Web site is known as a Web page. Unlike the pages in books, however,
Web pages can contain more information than you can see at once.
Scrollbars let you move the page up and down inside your browser win-
dow, which displays the text and graphics on the Web page.

Every Web page has a URL. As mentioned earlier, the URL of my
résumé is http://www.udel.edu/fth/resume.html. By analyzing this URL,
you can see that this Web page is stored in the fth folder (fth are my initials)
at the University of Delaware’s Web site. The filename of the Web page is
resume.html. The filename extension html is the standard format used for
documents on the Web. HTML stands for hypertext markup language.
You will learn HTML in the Web page authoring tutorial in Part II of
this book.

path/filename The filename is the name the file has on the server. If the file is in a folder or subfolder on the server, the filename
includes the path to the file as well as the name of the file. If a URL that begins with http does not contain a
filename, the default filename (usually index.html) gets served.

anchor The anchor is a named bookmark within an HTML file. Anchors are optional. If a URL does not contain an anchor,
the browser begins display at the start of the file.

protocol http

server name www.udel.edu

path/filename fth/resume.html

anchor professional



Surfing Concepts and Techniques

Surfing the Net is a lot more involved than channel surfing television. In-
stead of just flipping through the relatively limited number of channels
available on a TV, surfing the Net enables you to navigate a world full of
interconnected information, discover new sites you did not know about,
keep track of where you have been so you can easily get there again, and
download things that interest you. By practicing the surfing concepts and
techniques presented here, you can master the art of navigating the Net so
you can get where you want quickly and accomplish your purpose for go-
ing there. Even if you consider yourself an accomplished surfer, studying
these concepts will probably teach you some new techniques that will
make you even more productive in surfing the Net.

Entering URLs

Oftentimes you will have been given a specific URL or Web address that
you want to go to. For example, you may have seen an ad for a Sony prod-
uct that told you to go to the Web site www.sony.com for more informa-
tion. To go there (or to any other site for which you know the URL), you
simply type the URL into your Web browser’s address or location field,
and press the ENTER key. If your browser’s address or location field is not
visible, follow these steps to get the URL field onscreen and go to a URL
with Microsoft Internet Explorer:

1. Microsoft Internet Explorer calls the URL field the Address field.

2. If the Address field is not visible, pull down the View menu, select
Toolbars, and if the Address Bar is not checked, select the Address
Bar to display it. If the Address field still is not visible, click your
right mouse button on the toolbar and select Address Bar.

3. Click once inside the Address field to position your cursor in it.

4. Type the URL you want to go to. In this example, type
www.sony.com.

5. Press ENTER.

To activate the URL field so you can type a URL into it, click once in-
side the URL field to position your cursor there. Erase any URL that
might be there currently by dragging your cursor over the URL to select it
and then pressing the DELETE key to delete it. Or you can just position
your cursor at the end of the URL and backspace over the URL to delete
it. Now type www.sony.com and press ENTER. Your browser takes you to
the Sony site.

Home Pages

Home is a relative concept. For example, a person from London considers
England to be home. To fly to Hawaii, that person takes off from London’s
Heathrow airport. When someone from Los Angeles flies to Hawaii, how-
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ever, the plane takes off from the Los Angeles airport. So it is on the Web,
where your home page is your taking-off point. Many people create their
own home page, to which they link documents and resources they want
people who visit their home page to be able to access. Almost every com-
pany has a home page, as do government offices, schools, and colleges.
Home pages organize the information at that site and help you access it. If
you were considering going to graduate school at Princeton University, for
example, you could find out a lot about it by going to their home page at
www.princeton.edu.

A huge mass of information is out there on the Net. Other people’s
home pages help you make sense out of their stuff. Eventually, after you
complete the Web page creation tutorial in Part II, your home page will or-
ganize your stuff and help other people make sense out of it.

Default Pages

If you go to a Web site without requesting a specific document, you view
that site’s default page. For example, when you went to www.sony.com,
you were taken to the default page of the Sony site. The default page is often
the home page of the company or person who owns the site. In Chapter 6,
you learn how to make your home page function as the default startup
page for your Web site.

Links

Links are perhaps the most important surfing concept, because without
links, there would be no Web! Links form the pathways that interconnect
the documents and resources on the Web. You activate a link by clicking it.
There are two kinds of links: hypertext and hypergraphic.

Hypertext Links

A hypertext link consists of one or more words that you click to trigger the
events that are linked to the text. Hypertext links are also known as hot
words, because they make things happen when you click them. So you can
tell which words are hot, the hypertext links are underlined or printed in a
different color than the rest of the text. Usually, links you have not visited
are colored blue and visited links dark pink. When you move your cursor
over a hypertext link, the cursor shape changes from an arrow to a hand
pointer.

You can change the default color of the hot words by modifying your
browser’s preferences. To change the color of the hypertext links in
Netscape Navigator, pull down the Edit menu, choose Preferences, click
Colors, and click the color swatches for Visited Links and Unvisited Links.
In Microsoft Internet Explorer, pull down the Tools menu, choose Internet
Options, click Colors, and click the color swatches for Visited and Unvis-
ited links. Even though you can change the colors, however, it is recom-
mended that you not modify them unless you have a special reason for
doing so.
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Sometimes the color selections you make have no effect on the colors
you see on a Web page. That is because the Web page author may have pre-
set the hypertext links to specific colors that you cannot change. Unless the
author has preset the colors on the Web page, the color preferences you
choose will take effect.

Hypergraphic Links

Hypergraphic triggers are pictorial HotSpots you click to trigger events
linked to images on the screen. The images can be little icons or larger
graphics.

Well-designed Web pages make it obvious where to click to make differ-
ent things happen. Poorly designed pages can be confusing if they’re not
clear what will happen when you trigger a link. In Chapter 5, you will
learn how to design Web pages that make it clear what will happen when
users trigger a link.

Figure 2-2 shows a Web page with an interesting combination of hyper-
text and hypergraphic links. Its URL is http://www.loc.gov. Point your
browser there (to “point” your browser means to go to the URL) and try
triggering the different hypertext and hypergraphic links.
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FIGURE 2-2 Analysis of a Web page with a combination of hypertext and hypergraphic links. When you
mouse over these links, notice that your cursor changes shape to indicate that you are hovering
on a hot spot. �

Hypergraphic links

Hypertext links

note In Chapter 8, you learn how
to use cascading style sheets to change
the appearance of unvisited and visited
hyperlinks. Chapter 8 also teaches you
how to make the link’s appearance
change when users move their cursors
over the link. When you mouse over a
link, you are said to hover over it. The
color of a moused-over link is called its
hover color.



Image Maps

A graphic may have more than one hot spot; if so, clicking different parts
of the graphic triggers different links. Consider the question being asked in
Figure 2-3. The user is being asked to click Middle C on a piano keyboard.
The image has triggers on the region of the keyboard below C, above C,
and on Middle C itself. Depending on where the user clicks, the appropri-
ate feedback is given.

Figure 2-4 maps the triggers in Figure 2-3. The technique used to map
multiple triggers onto an image is known as an image map. In Chapter 7,
you learn how to create image maps.

Navigation Buttons

At the top of your browser you should see a row of navigation buttons
with names such as Forward, Back, Home, and Stop. Figure 2-5 shows
how the buttons appear in Microsoft Internet Explorer.

One of the most useful navigation buttons is the Back button. If you end
up someplace you did not want to go, clicking the Back button returns you
to the page from which you triggered the ill-chosen link. Conversely, the
Forward button moves you ahead to pages you visited earlier in your cur-
rent browsing session. Right-clicking on Back or Forward pops out a
menu that shows the whole path you covered, and you can click a site to
jump directly to it.
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FIGURE 2-3 The student is asked to click Middle C on a
music keyboard. �

FIGURE 2-4 Mapping of the triggers in Figure 2-3. �

Image Map Where’s Middle C?
Can you find Middle C on the music keyboard below? Click the key that you think’s
Middle C, and then I’ll tell you if your answer is too low, too high, or just right.

Image Map Where’s Middle C?
Can you find Middle C on the music keyboard below? Click the key that you think’s
Middle C, and then I’ll tell you if your answer is too low, too high, or just right.

Can You Find Middle C on an Image Map?
Now you can have a little fun trying out the Middle C image map illustrated in Figure 2-3. This image map is a
little game that teaches users how to find Middle C on a music keyboard. To play the game, follow these steps:

1. Go to www.udel.edu/fth/middle-c. Your browser displays the music keyboard illustrated in Figure 2-3.

2. Try clicking different places on the keyboard, and observe the feedback you get.

3. If you do not know where Middle C is, the feedback will eventually teach you.

4. You can also look up the answer by studying Figure 2-4.

5. In Chapter 7, you learn the HTML codes for creating this kind of an image map. By using these
codes, you can create an image map for any conceivable image you would like to present onscreen
for users to interact with and make different things happen depending on where the user clicks.

Try This!

note Macintosh users, you trigger
the menu on a Mac by holding down
CONTROL during the click or by holding
down the mouse button until the menu
pops out.



Any time you want to return to your browser’s default home page, just
click the Home button. If you want to change the Internet Explorer’s de-
fault home page, follow these steps:

1. Pull down the Tools menu and choose Internet Options.

2. Click the General tab, if it is not already selected.

3. In the Address field, type the URL of your desired home page.

4. Click OK to close the dialog.

Manipulating URLs

You can play some tricks with URLs to help find information. For ex-
ample, suppose you have been told to go to the URL http://
www.microsoft.com/windows/ie/enthusiast/default.asp for a list of tips to
help you learn more about the features in Microsoft Internet Explorer. You
find the list helpful, and you are curious to see what else is available at this
site. By progressively stripping off the subfolder names of the path to the
original document you were given, you can go to the higher levels of the
Web site and use them as surfing-off points. For example, http://
www.microsoft.com/windows/ie/ takes you to a menu of other links re-
lated to Microsoft Internet Explorer. Stripping off the last part of the URL
(i.e., /ie) and trying http://www.microsoft.com/windows/ brings up a list of
feature articles related to Windows technologies. Going all the way back
to http://www.microsoft.com takes you to the Microsoft default page.

Stripping off parts of the URL in this manner normally brings you to the
home page of the Web site where the page is hosted. Taking a look at the
hosting site’s home page reveals the source of the information, which can
help you judge how reliable the information is. Remember that anyone can
publish pages to the Web. If you discover that one page about airplanes,

for example, came from the Smith-
sonian’s air and space museum and
another page came from a four-
year-old child learning how to
build paper airplanes, you would
consider the page from the Smith-
sonian to have greater authority.
Going to the source of the informa-
tion can also help you find related
information available at the site
and correct errors in the URL if the
original file could not be found.
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FIGURE 2-5 Navigation buttons in Microsoft Internet Explorer. If these buttons are not
visible, pull down the View menu, choose Toolbars, and select Standard Buttons.

If the navigation buttons still do not appear, right-click the toolbar and choose Standard Buttons. �

Using the Stop Button
to Interrupt Your
Browser
Sometimes you may think the Internet
has gotten stuck after you click a trigger
to go somewhere. If you wait for a while
with no response, try clicking the Stop
button to cancel the request, and then

click the trigger again. This
usually gets things moving
again. Another use of the

Stop button is to cancel a process that
is taking too long. For example, you may
have clicked a trigger that downloads a
movie that could take more than an
hour to arrive over a slow Internet
connection. Clicking the Stop button
interrupts the download so you do not
have to wait an hour.

Inside
Info



Bookmarking Favorite Sites

Web browsers have built-in support for bookmarks, which make it quick
and easy for you to take note of your favorite Web pages and return to
them later on. In a Web browser, a bookmark is a pointer to a Web page
that enables you to jump directly to that page, without having to navigate
the Web to get there.

As you surf the Net and become familiar with the wealth of resources
available, you will begin to favor certain sites over others. To save time get-
ting to your favorite sites, you can bookmark them. To bookmark a site on
the Web, simply pull down the Favorites menu and click Add to Favorites.
To jump to any site you bookmarked, pull down the Favorites menu and
select the bookmark you want. Your browser will take you to the
bookmarked Web page.

Bookmark Folders

You can organize your bookmarks in folders. This is recom-
mended if you have a lot of bookmarks so you can organize
them according to topics. You might make a folder called
SearchEngines, for example, to hold bookmarks to your favor-
ite search engines. Similarly, you might create a folder called
Shopping in which you bookmark your favorite shopping
sites. To create a bookmark folder, follow these steps:

1. Pull down the Favorites menu and choose Add to
Favorites; the Add Favorite dialog appears.

2. Click the Create In button to expand the dialog to
appear as shown here.
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Manipulating the URL Field
You can easily manipulate URLs by using your browser’s Address field. If your browser’s Address field is not
visible, pull down the View menu and select Toolbars; if the Address Bar is not checked, select the Address Bar
to display it. Click once inside the Address field to position your cursor there and erase anything that already
appears in the field. Then type the URL http://www.loc.gov/exhibits/flw/flw03.html and press ENTER to go
there. Next complete the following steps, which will help you learn how to manipulate a URL:

1. Position your cursor at the end of the Address field and use the backspace key to erase the last part
of the URL, which is /flw03.html. Press ENTER. Your Web browser displays the Web page of the
manipulated URL.

2. Once again, position your cursor at the end of the Address field and use the backspace key to erase
the last part of the URL, which is /flw. Press ENTER to go to the manipulated URL.

3. Repeat this process for each part of the URL until all you have in the Address field is
http://www.loc.gov—this is the URL of the Library of Congress Web server. LOC stands
for Library of Congress.

Try This!



3. Click the New Folder button to make the Create New Folder
dialog appear.

4. In the Folder Name field, type the name you want the new folder
to have.

5. Click OK to close the Create New Folder dialog, and click OK to
close the Add Favorite dialog.

6. To bookmark a Web site in a folder, pull down the Favorites
menu, choose Add to Favorites, click Create In, select the desired
folder, and click OK.

Importing and Exporting Bookmarked Favorites

Bookmarked favorites are so important that the browser has a built-in
mechanism for importing and exporting them. Suppose you just bought a
new computer. Its browser will not have any knowledge of the
bookmarked favorites on your old computer. You can use the export/im-
port mechanism to move your bookmarks from your old browser to your
new computer’s browser. Another situation in which you need to be able to
export bookmarks is when you want to share your bookmarks with other
users, such as at home, at school, or in your workplace. At the end of this
chapter, Lab Project 2-2 gives you practice exporting bookmarks.

Retracing Your Steps: The History Folder

The IE browser remembers your most recently visited sites and makes it
possible for you to jump back to a previous site without having to press the
Back button repeatedly to back through the sites one by one. To jump back
to a site you previously visited, follow these steps:

1. Click the History button; a History pane opens up to provide a
visual display of the sites you visited.

2. Click a category in the history to expand it, and then click a Web
site to go there.

3. If you want to hide the history, click the X in the upper-right
corner of the History pane to close it.

Auto Completion

The IE browser has a feature called Auto Completion. If you begin typing
into the browser’s URL field the address of a Web site you visited previ-
ously, the browser auto-completes the entry to save you time. If you do not
mean to go exactly to the address that gets auto-completed, just keep on
typing, and the auto-completed address adjusts to what you type.

When you begin typing a Web address you visited previously, IE pops
out a menu of similar addresses you visited. If you see the address you want
in the menu, just click the address to go to it.
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Managing Your Web Browser’s Cache

When you surf the Web, your browser keeps copies of the most recently
visited Web sites in a place on your hard disk called the cache (pronounced
cash). As you navigate back and forth around the Web and revisit one of
the sites in the cache, your browser checks to see if the timestamp on the
Web site has changed since your local copy was cached. If the site has not
changed, the browser redisplays the site from the cache instead of down-
loading it again. Thus the cache speeds your use of the Web and reduces
traffic on the Net.

If you want to increase the number of pages your cache can hold, you
can change the size and location of the browser’s cache. You can also purge
(i.e., delete) the cache, which you might want to do if you have been read-
ing sensitive information that you would not want someone else using
your computer to find. Purging the cache can also fix problems when Web
pages do not work properly, especially Web pages with Java, for which
purging the cache causes the Java to reload. To manipulate your cache in
the IE browser, follow these steps:

1. Pull down the Tools menu and choose Internet Options; the
Internet Options dialog appears.

2. If the General tab is not already selected, click the General tab.
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Creating More Screen Space
No matter how large your computer screen is, you will sometimes wish it were larger so more information
would fit into it. You can increase the viewing area of your Web browser by turning off some of the options
that make your browser use extra screen space. For example, turning off the display of the URL field saves a
little screen space and increases the viewing area inside the browser. Turning off the navigation buttons frees
even more screen space. You can still navigate by using your browser’s shortcut navigation keys, or you can
turn the navigation buttons back on again when you want them to reappear. To create more screen space with
the IE browser, follow these steps:

1. Pull down the View menu, choose Toolbars, and see if the Standard Buttons option is checked; if so,
click Standard Buttons to turn the buttons off.

2. Pull down the View menu, choose Toolbars, and see if the Address Bar option is checked; if so, click
Address Bar to turn it off.

3. Pull down the View menu and see if the Status Bar option is checked; if so, click Status Bar to turn it off.

4. To turn the toolbars back on, pull down the View menu, select Toolbars, and click the toolbars to
turn them back on.

5. To turn the status bar back on, pull down the View menu and select Status Bar.

6. Another way to create more screen space is to click the IE browser’s full-screen button, which is the
F11 function key. To return to normal view, press F11 again. This full-screen option is also found on
the View menu.

Try This!



3. The Temporary Internet Files group contains your cache
controls. Click the Settings button to make the cache settings
appear, as shown to the left.

4. You can change the amount of your hard disk that is used for
the cache by dragging the slider. Do not change this unless
you’re sure you want to modify this setting; most users never
need to change this.

5. To move the cache to a different folder, click the Move Folder
button. Do not do this unless you know what you are doing.
Most users never need to change the location of the cache.

6. To view the contents of your cache, click the View Files button.
This opens a file window, which you can close when you are
done viewing the file window’s contents.

7. Click OK to close the Settings dialog.

8. To purge the cache, click the Delete Files button in the Temporary
Internet Files group.

9. Click OK to close the Internet Options dialog.

Advanced Browser Settings

IE comes with scads of settings that let you adjust all kinds of things. Ear-
lier in this chapter, for example, you learned how to set the home page and
change the browser’s cache settings. Here, we take a look at advanced set-
tings that affect how the browser works behind the scenes.

To reveal the advanced settings, you pull down the Tools menu and
choose Internet Options. When the Internet Options dialog appears, you
click the Advanced tab to reveal the advanced options. There are so many
advanced options that you will see a scrollbar that you can move down
and up to reveal all the settings. Some of the settings are self-explanatory.
The setting that says “Automatically check for Internet Explorer up-
dates,” for example, is self-explanatory. If you check it, the browser will
automatically check to see if newer versions or security patches are avail-
able. If you do not check this option, you’ll need to run Windows Update
to check for updates. You can run Windows Update by pulling down the
Tools menu and choosing Windows Update.

Some of the other options will not make as much sense until you com-
plete the later chapters in this book. In the Accessibility section, for exam-
ple, the option to always expand ALT text will not make sense unless you
know what the ALT tag does. In Chapter 9, “Making Web Pages Accessi-
ble,” you will learn that the ALT tag creates alternate text, which is an ac-
cessibility feature that does not otherwise appear unless the user mouses
over the image that has alternate text. Chapter 9 teaches how to create al-
ternate text and experience how it works onscreen.

Many of the advanced options are there for security reasons, to help pro-
tect you from downloading viruses, worms, Trojans, or other kinds of
Internet attacks. The option to warn about invalid site certificates, for exam-
ple, is a setting you will want to leave on. You will learn about certificates and
other advanced security settings in Part III, Networking Fundamentals.
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Resetting the Browser Settings

Should a situation arise in which you want to reset the browser to its factory
settings, IE has a feature built right in to handle this. Follow these steps:

1. Pull down the Tools menu and click Reset Web Settings.

2. The Reset Web Settings dialog appears as shown here.

3. If you do not want to reset the home page, click the box to
unselect the option that resets your home page.

4. Click Yes to reset the browser settings, or click No if you
decided not to do it.

Wireless Web Browsing and the
Wireless Application Protocol (WAP)

The Wireless Application Protocol (WAP) was invented to provide mo-
bile telephone users with a way of accessing the Internet by routing re-
quests through a WAP server that translates Web pages into a format
appropriate for display on mobile phones. Depending on the capabilities
of the phone being used, the WAP server may strip off the graphics and
send to the phone only the textual portions of the Web page. The text is
formatted according to the rules of a markup language called WML,
which stands for Wireless Markup Language.

As this book goes to press, mobile phones are coming out with multime-
dia capabilities that will diminish the need for a WAP server. As the phone
takes on more of the capabilities of a personal computer, the need for
translating the Internet’s TCP/IP signal into a specially formatted WAP sig-
nal will diminish. To learn more about the evolving mobile Internet tech-
nologies, go to www.openmobilealliance.org. To see how a Web site will
appear when viewed on a mobile phone via WAP, go to www.gelon.net and
use the Wapalizer. Type in the URL you want to view, and then click the
Wapalize button to see how the site will appear on the phone.

Handling Multimedia Objects, Plug-ins, and Viewers

As defined in my Multimedia Literacy textbook, “multimedia is the use of
a computer to present and combine text, graphics, audio, and video with
links and tools that let the user navigate, interact, create, and communi-
cate” (Hofstetter, 2001:2). More simply stated, multimedia brings the
Web to life with stereo sound, colorful movies, and alluring animations.
To hear the sound or see the video on a Web page, your Web browser must
be configured to handle the multimedia resource contained on the Web
page. Multimedia is an emerging technology that is undergoing a lot of re-
search and development. As a result of this research, there are a lot of dif-
ferent ways to do multimedia.

Web browsers use a clever approach to handling this diversity. First, the
browsers have built-in support for the most common kinds of multimedia.
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You do not need to do anything special to get these to work as long as you
have a multimedia computer that is capable of making sound and showing
movies. Second, multimedia companies make plug-ins and add-ins that in-
stall inside the browser to play their company’s brand of multimedia files.
Third, some browsers enable you to define so-called helper apps that the
browser launches to handle other kinds of multimedia files.

This chapter shows you how to do all three kinds of multimedia brows-
ing. You will learn how to use built-in support and define helpers for file
types that are not built in. You can go to this book’s Web site to download
the most popular plug-ins and add-ins for handling proprietary multime-
dia file types. Then you will be ready to visit some of the hottest multime-
dia Web sites in the world.

Built-In Browser Support for Multimedia

The first browsers had no support for multimedia built in. Everything had
to be handled through a so-called helper app, an application the browser
launches to help it handle something for which a player is not built in. To-
day, the trend is for browsers to contain built-in support for the most com-
mon multimedia file types.

Audio Controls

Internet Explorer comes preset to play audio through the Windows Media
Player shown in Figure 2-6. If you want to install the latest version, go to
www.microsoft.com/windows/windowsmedia and follow the link to
download Windows Media Player. To find out whether your browser is
configured to use the Windows Media Player, you can simply browse to
some audio to find out what application launches to play it. On this book’s
Web site, you’ll find an example of an audio file you can play. It is a wave-
form audio file of me greeting you. To hear this greeting, go to Chapter 2 of
the Web site and click the link to my audio greeting. If the Windows Media
Player is configured to play your audio, you will get controls like those dis-
played in Figure 2-6. Another popular player is Apple QuickTime. If your
browser is configured to play audio via Apple QuickTime, the controls
will appear as illustrated in Figure 2-7.

FIGURE 2-6 Windows Media audio
controls �

FIGURE 2-7 QuickTime audio controls �

Drag the slider to move to
different places in the audio.

Click here to play the audio.

Click here to pause the audio.

Drag the volume control
to make the sound
louder or softer.

Click here to play or stop the audio.

Click here to rewind the audio.Drag the slider to move to
different places in the audio.



Video Controls

The IE browser is preset to play video by the Windows Media Player, illus-
trated in Figure 2-8. Another popular video player is QuickTime for Win-
dows, shown in Figure 2-9. The next part of this chapter teaches you how
to configure the IE browser on Windows computers to play the video via
QuickTime for Windows, should you wish to do so. You can download
the latest version from www.apple.com/quicktime.
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FIGURE 2-8

Microsoft’s

Windows Media

Controller

Click here to
play the video.

FIGURE 2-9

Apple’s QuickTime

movie controller

Drag the slider to move to
different places in the video.

Click here to stop the video.

Drag the volume control to make
the sound louder or softer.

Drag the slider to move to
different places in the video.

Click here to
adjust the sound.

Click here to play or
pause the video.

Click here to
skip back.

Click here to
skip ahead.

Step-by-Step 2-1
Windows Filename Associations for Internet Explorer
In the Windows operating system, Microsoft
Internet Explorer uses the Windows filename
associations to determine what application will
be used to handle different multimedia file types.
When you trigger the playing of a multimedia
file, your browser looks to see what application is

associated with that type of file on your
computer, and the associated app then plays
the file. If you want to inspect or change the
filename associations on your computer, you
can do so with the Windows Explorer. Follow
these steps:

Step 1 Get the Windows Explorer running, pull down the Tools menu, and choose Folder
Options.

Step 2 Click the File Types tab, scroll the list to find the filename whose association you want to
see, and click once on the filename to select it. Figure 2-10 shows the setting for an
MPEG movie file.

Step 3 To change the filename association, click the Change button; the Open With dialog appears.



Streaming Media

As you learned in Chapter 1, the process of digitalization is changing the
world by converging the world’s communications media into a digital data
stream that can be delivered over the Internet. No matter what you want to
say, and no matter how you want to say it—text, speech, graphics, anima-
tions, music, video—it can all be digitized and published to the Web. When
a user clicks to access your content, it gets delivered over the Internet to the
user’s Web browser.

When content gets digitized, however, some of the media create larger
data files than others. Consider this paragraph, for example. If you type it
into a word processor, this paragraph takes up 989 bytes of file space. That
is a relatively small amount of data that can be transmitted over the
Internet very quickly. Because it is a small amount of data, we say it is low
bandwidth, meaning not much time or space is needed to send it over the
Web. When the user clicks to see the paragraph, the text appears very
quickly. If you read this paragraph aloud and record it with your com-
puter’s microphone, on the other hand, the resulting audio file is many
times larger. It has higher bandwidth, and it takes longer to transmit over
the Internet. Add a webcam to record video while you speak into the mi-
crophone, and the file becomes very large. Its bandwidth is now so high
that the user may lose interest while waiting for the video to arrive and the
content to start playing.

Streaming was invented to avoid this kind of delay. Multimedia content
creators are using streaming to deliver high-bandwidth media quickly and
efficiently over the Internet. This enables you to visit Web sites where audio
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Step 4 In the Open With dialog, click one of the
recommended programs or click the Browse
button to choose a different program.

Step 5 Make your changes, and then click OK. Do not
make any changes, however, unless you are
sure the program you are choosing can handle
this type of file properly. In this example, the
QuickTime player would be a reasonable
choice if you want MPEG movies to play in
QuickTime instead of in Microsoft Media
Player.

FIGURE 2-10 When you click to inspect the filename association
of the MPEG movie file type, you can see what

application is configured to handle it now. If you want to change this handler,
click the Change button and follow the onscreen instructions. �



and video recordings are standing by, ready to begin streaming on demand
to your computer as soon as you click them. In addition to playing prere-
corded streams, you can also visit real-time sites, such as news channels and
radio stations that are playing right now, using streaming media to deliver
what is happening right now to your desktop.

What Is a Stream?

A stream is a real-time feed from an audio or video source, encoded in
such a way that the media can begin playing steadily without making users
wait for the entire file to download to their computers. Streaming media,
therefore, is the simultaneous transfer and display of the sounds and im-
ages on the World Wide Web. Streaming media enables users to watch and
listen to a movie while it is being sent to their browsers, for example, in-
stead of waiting minutes or hours to download and then play it.

Streaming media can also be used to broadcast real-time events over the
Internet. Webcasting is the term used to describe the simultaneous broad-
cast of a live event over the Web. Webcasting software gives you the option
to make an archive, which means to save the Webcast in a computer file
from which you can replay the broadcast sometime after the event. On the
Web, the commercial news sites such as cnn.com, msnbc.com, cbs.com,
and abc.com make news archives available. When you click to play an ar-
chive, you see the same video as the audience that viewed the stream live.

When this book went to press, the three most popular platforms for
streaming media were Apple QuickTime, Microsoft Media Player, and
RealNetworks. All three of these products plug in seamlessly to the leading
Web browsers.

Plug-ins

A plug-in is a software component that adds functionality when installed
into an existing computer application. The advantage of plug-ins over
helper apps is that the plug-in usually gives you better integration of the
media. Plug-ins normally make multimedia play in the browser’s window,
whereas helper apps often launch a separate window to play the file.

Apple QuickTime

One of Apple Computer’s greatest gifts to the world is QuickTime, Ap-
ple’s brand of multimedia. Originally for the Macintosh only, QuickTime
is now one of the finest cross-platform tools available for multimedia cre-
ation and delivery. It plugs in seamlessly to Microsoft Internet Explorer,
and it works on Windows as well as Macintosh computers.

The QuickTime player is free. For a modest fee, you can upgrade the
free player to QuickTime Pro, which lets you edit audio and video clips as
well as play them. To download either the free player or the more fully fea-
tured QuickTime Pro, go to www.apple.com/quicktime.
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Microsoft Media Player

Microsoft is aggressively pursuing the market for streaming video and has
created its own product line of streaming media servers. The player, which
is free, is called the Microsoft Media Player. If you have Windows, there is
probably a version of the Microsoft Media Player installed on your
computer. To find out, click your computer’s Start button, select Pro-
grams, and look under Accessories or Multimedia for the Microsoft
Media Player. To check whether a more recent version is available, go to
www.microsoft.com/windows/windowsmedia.

RealNetworks

RealNetworks is one of the best-known multimedia streaming companies
on the Internet. Marketed under RealOne, which is the RealNetworks
brand name, the two main families of products are RealOne Music and
RealOne Player. True to its name, RealOne Music provides more than
75,000 songs by top artists plus more than 2,000 radio stations. RealOne
Player adds moving pictures to the audio experience. Best of all, the basic
player is free. According to RealNetworks, the RealOne Player can play
more than 85 percent of the multimedia content on the Web.

The free RealOne Player includes the media player, a music jukebox,
and a built-in media browser to play a wide variety of streaming media for-
mats on the Web. The free RealOne Player does not include access to ex-
clusive RealOne channels or programming, premium player features, or
RealOne member services.

To start listening or watching live streaming content, go to
www.real.com and follow the link to the Real Guide, which connects you
to networks and channels that use the RealOne Player. If your computer
does not have the RealOne Player installed or if your player is outdated,
you will be prompted to install the latest version of the player. There is also
a more fully featured version of the player called RealOne Player Plus, for
which you pay a small fee to download.

To learn more about RealOne Player and RealOne Player Plus and to
download the player of your choice, go to www.real.com and follow the
link to free downloads. RealNetworks has proposed that its streaming
protocol become an Internet standard. The name of the protocol is Real
Time Streaming Protocol (RTSP). If you want the technical background,
go to www.ietf.org/rfc/rfc2326.txt.

Flash

Flash is a very popular multimedia plug-in. Distributed by Macromedia,
the Flash Player is freely downloadable from www.macromedia.com. Ac-
cording to Macromedia, the Flash Player is installed on more than 97 per-
cent of the Internet’s end-user computers. Macromedia Flash is so popular,
in fact, that the Flash Player is built right into the latest browsers.

Web designers create Flash applications with a tool called Macromedia
Flash MX Professional. Figure 2-11 shows that this tool uses a timeline
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metaphor. Authors create rich media content by dragging media objects
and behaviors onto the timeline. In addition to creating animated slides,
movies, and sound tracks, the latest version lets authors import Adobe
PDF documents, design Web forms, and use CSS to create a common style
for the Flash plug-in and the surrounding Web page.

To experience some examples of award-winning Flash applications, go
to www.macromedia.com, click Showcase, and follow the link to the Flash
Showcase.

Browser Support for Plug-Ins

Both Netscape and Microsoft have special support for plug-ins. If you
have Netscape Navigator, you can pull down the Tasks menu and choose
About Plug-ins to find out what plug-ins are installed in your browser.
Then you follow the links to Netscape’s Index of Plug-ins to download
other plug-ins you want.
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FIGURE 2-11 Flash developer Becky Kinney created this light-switch animation for use in
a microscope simulation at the University of Delaware. You can run this

application by browsing to www.udel.edu/Biology/ketcham/microscope/scope.html. To contact Becky,
send e-mail to becky@moonlightmultimedia.org. Her company’s Web site has a section devoted to
“Flash for Educators” at http://moonlightmultimedia.org/f4e, which offers free tools and templates.

Turn the light on and off by dragging the switch
or clicking the spot you want it to move to.

This action moves the switch, causes the little
green light to glow or not glow, and causes
other lights to appear elsewhere on the scope.

Drag this rheostat wheel to
control the intensity of the light.



If you have Microsoft Internet Explorer, pull down the Tools menu and
choose Windows Update. This takes you to the Windows Update Center,
which will take a look around your computer, see what options you have,
and give you a list of new items you can add. Especially useful is the notifi-
cation of new drivers that may be available for devices connected to your
computer.

Security Risks

Every user needs to be aware that whenever you download code that exe-
cutes on your computer, you run the risk of getting a virus that could cause
serious problems on your PC. If you are downloading code from reputable
vendor sites, such as Microsoft, Apple, and Macromedia, the chance of
your getting a virus is highly unlikely. Downloading code from unknown
sources, however, could open the door to trouble.

Even if the code you download is virus-free, it could contain back doors
and loopholes through which malicious programmers called crackers
could send you viruses or cause other problems on your computer. For ex-
ample, a security hole in one of the major vendor’s plug-ins allowed mali-
cious Web page developers to create a movie that could read a user’s e-mail
messages and upload them to a server, without the user knowing anything
about it. Instructions on how to do this were published on the Internet,
where any malicious programmer could learn how to do it.

The vendors respond quickly to plug such loopholes by providing fixes
called patches. To make sure you have the latest patches, check the down-
load center for your brand of Web browser. If you have Microsoft Internet
Explorer, for example, pull down the Tools menu and choose Windows
Update.

Object Development and Runtime Environments

In computing, an object is a software entity that is programmed to per-
form certain tasks or behave in certain ways depending on the context in
which it is used. Objects can be used on Web pages to provide dynamic
content. A page that tells you what the current time is, for example, uses a
Date object to determine the current date and time to print onscreen. You
will learn how to use the Date object in the JavaScript Clock tutorial in
Chapter 8. Objects can also be used to display animations onscreen and
provide users with controls that can calculate, simulate, and illustrate real-
time data onscreen.

Java

Java is an object-oriented programming language invented by Sun
Microsystems. Its main advantage over other programming languages is
machine independence. Instead of creating code that can run only on a spe-
cific machine (such as a Macintosh or a Windows PC), Java creates an in-
termediate code that can run on any computer that knows how to interpret
it. As a result, Java runs under Windows, Macintosh, UNIX, Linux, and
many other operating systems, such as the OS9 system used to program
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set-top boxes for the Internet. Machine independence has made Java one
of the hottest languages on the planet. For more information about the
Java programming language, go to java.sun.com.

Java Applets

Java can be used to create a little application called an applet that can be
transmitted over the Internet as part of a Web page. Applets bring Web
pages to life in several ways. For example, scrolling tickers can move infor-
mation across the screen. You can use a mouse to rotate three-dimensional
objects that would otherwise appear flat on a static Web page. Active
spreadsheets let users manipulate data right on the Web page.

With Java, Web pages can even contain graphics editors that enable us-
ers to create their own graphics. Applets can contain games, such as Hang-
man or Tic-Tac-Toe, or more complex simulations. By following this
book’s Web site link to the Tokamak Nuclear Reactor, for example, you
can run the same nuclear reactor simulation that Princeton University sci-
entists use to determine optimal settings for tokamak fusion reactors.
Figure 2-12 shows how the tokamak applet lets you manipulate sliders
that control the plasma density, heating power, and magnetic field. By let-
ting you play with these parameters, the applet enables you to develop an
intuitive feel for the process scientists go through in designing tokamak re-
actors. To explore a wide range of Web pages that use Java applets, go to
java.sun.com/applets.

JavaScript

Developing applets in Java is time-
consuming and requires advanced
programming skills. Does this mean
Web page programming is beyond the
scope of the typical Web page author?
No, thanks to JavaScript, a client-side
object-based programming language
that enables you to create dynamic
Web pages without having to become a
ful l - f ledged Java programmer.
JavaScript has become so popular that
virtually all browsers support it, in-
cluding IE, Mozilla, and Safari. Thus,
JavaScript has become the best way for
nonprogrammers to create dynamic
Web pages that will work in the latest
versions of the browsers. JavaScript
runs differently on different platforms,
however, so you need to test any scripts
you create with any browsers that will
be used to execute them. Chapter 8
steps you through a little tutorial to get
you started with JavaScript.
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FIGURE 2-12 A fascinating virtual field trip awaits you at the Internet Plasma
Physics Education eXperience (IPPEX) online, where the tokamak

nuclear reactor applet lets you manipulate sliders that control the plasma density, heating
power, and magnetic field. By dragging the three sliders and clicking the Start button, you
can observe the effects different settings have on the reaction onscreen and thereby
discover how these parameters interact. �



For more information about the origins and applications of JavaScript,
follow this book’s Web site link to JavaScript Developer Central. There
you will find sample code for creating rollovers, graphs, menus, dialogs,
calendar pop-ups, and layering effects. Figure 2-13 shows one of the roll-
over effects you can create with JavaScript. For even more JavaScript re-
sources, go to www.cnet.com and search for JavaScript.

C#

The C# (pronounced C sharp) programming language is the latest in a se-
ries of languages that have progressed from the original C through ver-
sions called C+ (pronounced C plus) and C++ (C plus plus). The C#
language was invented by Microsoft for use in the .NET (pronounced dot
net) Framework, the software architecture that underlies the Windows
2003 operating system. You can use the C# language to create native Win-
dows applications as well as Web applications that use the browser win-
dow as the display surface.

J#

J# (pronounced J sharp) is Microsoft’s version of the Java programming
language. Like C#, the J# language was created for the .NET Framework.
A development environment called Visual Studio .NET provides program-
mers with a powerful set of tools for building applications for Microsoft
Windows, the Web, and mobile devices. To learn more about Visual Studio
.NET, go to msdn.microsoft.com/vstudio.

JScript

True to its name, Microsoft’s JScript language is very similar to JavaScript.
If you know one, it is easy to learn the other. Where the two languages dif-
fer, however, is in where they run. As you learned earlier in this chapter,
JavaScript is a client-side language, which means the scripts run in the
browser itself. JScript, on the other hand, was invented as a server-side lan-
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FIGURE 2-13 A rollover effect created with JavaScript at the Library of Congress. To try this effect, go to
www.loc.gov and move your cursor over the menu choices. Notice that the photo on the

right changes as you mouse over the choices. �



guage, which means the scripts run on the server. On the server, scripts can
access databases and file systems that, primarily for security reasons, are
not accessible in JavaScript. JScript began as one of Microsoft’s Active
Server Page (ASP) languages. There is also an ASP.NET version that is
called JScript.NET.

VBScript

Visual Basic (VB) is one of Microsoft’s legacy languages. It lives on in the
form of VBScript, which is one of the ASP scripting languages, and
VBScript.NET, which is the .NET Framework version. You can use
VBScript to program virtually anything you can script in JScript, and for
that reason, my Advanced Web Design textbook splits into columns to
show tutorial examples in both JScript and VBScript.

ActiveX

ActiveX was begun by Microsoft as a way to create and distribute infor-
mation over the Internet, using existing software applications and data. At
first, developers were somewhat reluctant to embrace the ActiveX tech-
nology because it was not an open standard, as was Java. In 1996,
Microsoft released ActiveX to The Open Group, an industry consortium
experienced in promoting cross-platform technologies. As a result,
ActiveX is widely accepted by Windows developers across the industry today.

ActiveX involves three concepts: controls, scripts, and documents.
ActiveX controls enable a wide variety of applications and content to be
embedded in HTML documents. Through Microsoft’s object linking and
embedding technology, you can use ActiveX controls to incorporate any
supported data type directly into the window of an ActiveX-enabled Web
browser such as the Microsoft Internet Explorer. More than a thousand
ActiveX controls are available, from multimedia sound and video players
to spreadsheets, charts, graphs, calculators, and paint programs. The
Microsoft Internet Explorer itself is an ActiveX control that can be embed-
ded inside other applications. For more information, follow this book’s
Web site link to ActiveX. To see dozens of controls you can download and
use, follow the link to the CNET ActiveX Control Library.

Objects and Security Issues

Because embedded objects cause software to be downloaded to your com-
puter at runtime, you run the risk of downloading viruses, worms, and
Trojans. A virus is malicious or unwanted code that installs itself on your
computer without your knowledge by hiding inside other programmed
objects. Viruses are dangerous because they can consume all the memory
on your computer, destroy data, and spread across the network to other
computers that are connected to yours. A worm is a special kind of virus
that can replicate itself without hiding inside other objects. A Trojan (also
called a Trojan horse) is a malicious application that masquerades as a de-
sired object that you download knowingly to your computer. When the
Trojan executes, it can take over or destroy the data on your computer.
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The next part of this chapter covers the steps you can take to configure the
browser’s security settings to minimize the risk of downloading these
kinds of attacks.

Configuring Browser Security

Anyone who has been the victim of an Internet attack will understand why
browser security is important. Attackers who gain access to your com-
puter can corrupt or destroy data, rendering the computer useless except
perhaps as a very expensive paperweight. Over the years, I have been the
victim of two attacks so severe that my computer had to be totally refor-
matted and rebuilt from the ground up. Thankfully, no data was lost, be-
cause I have learned to keep backups of all essential data. Everyone
reading this book must also form such a religious habit of backing up all
data, anything you wouldn’t want to lose. Even if you have complete back-
ups, however, you can lose a lot of precious time if you need to rebuild a
corrupted system. That is why the browser has built-in ways of helping to
safeguard against these kinds of attacks.
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The Story of the
Trojan Horse
The term Trojan horse comes from a story
in Homer’s Iliad in which the Greeks gave
a giant wooden horse to their enemies, the
Trojans,who thought the horse was a

peace offering. After the
Trojans brought the horse
inside their city walls, however,

Greek soldiers sneaked out of the horse’s
hollow belly and opened the city gates,
allowing the rest of the Greek army to
come in and capture the city of Troy.

Inside
Info

Step-by-Step 2-2
Configuring Security Zones
One of the ways the browser helps you safeguard
against attacks is by letting you configure different
security settings for different zones. On the Internet,
a zone is a predefined range or selection of Web
sites or addresses. The IE browser lets you configure
different security settings in four different zones. As
illustrated in Figure 2-14, these four zones are called

■ Internet, which contains all Web sites you
haven’t placed in other zones

■ Local intranet, which contains all Web
sites on your organization’s intranet

■ Trusted sites, into which you place
Web sites you trust not to damage your
computer or your data

■ Restricted sites, into which you place Web
sites you believe could cause damage to
your computer or your data.



Finding Things with Search Engines

The Internet is the richest source of information on the planet. According
to Bergman’s (2001) white paper on the deep Web, more than 100,000
searchable databases exist, containing nearly 550 billion documents, 95
percent of which are publicly available.

Just about anything you could ever want to know is available online.
Especially for students and scholars conducting research, the Internet is a
fantastic resource for finding out what has been done in your field.

Although so much information is available online, finding what you
want to know is not always easy because knowledge gets organized and
stored in different ways. To find what you want, you need to understand
how the different kinds of search engines work. Then you will be ready to
conduct a search that has a better chance of finding what you seek.

Chapter 2: Surfing and Searching the Internet

To set the security settings for any one of these
zones, follow these steps:

Step 1 Pull down the IE Tools menu, choose
Internet Options, and click the Security
tab to make the security zones appear, as
illustrated in Figure 2-14.

Step 2 Click the name or icon of the zone you
want to change.

Step 3 To set the security level to Microsoft’s
recommended settings, click the Default
Level button.

Step 4 To change the security level, move the
slider up to make the settings more
restrictive or down to make the settings
less restrictive. If you move the slider lower
than Microsoft recommends, you will get a
warning to that effect.

Step 5 When you are in the Local intranet,
Trusted sites, or Restricted sites zone, the
Sites button is activated. To put specific sites into one of those zones, click the Sites
button when you are in that zone and follow the onscreen instructions.

Step 6 If you want to customize the IE security settings, you can do so by clicking the Custom
Level button to bring up a detailed list of security settings. To change a setting, click to
select the option you want and then click OK to make the changes take effect or click
Cancel to ignore the changes.

FIGURE 2-14 When you pull down the IE Tools
menu, choose Options, and click

the Security tab, you can inspect or change the security
settings for the four IE security zones. �



Subject-Oriented Searching of Directories

When you research a topic, it is wise to begin by conducting a subject-
oriented search of one or more of the Web’s directories. This will tell you
how much information is available about your topic as a subject that other
people have written about. The subject-oriented directories use a combi-
nation of human beings and robots called spiders that search the Web con-
tinually, organizing what is found into a hierarchical directory of topics.
When you conduct a subject-oriented search, the search engine searches
this directory and provides you with a list of items related to your topic. To
retrieve the item, you simply click it.
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Step-by-Step 2-3
Searching Yahoo!
As this book goes to press, Yahoo! is the most
popular subject-oriented directory. Its Web address
is www.yahoo.com. There is also a version for kids
at www.yahooligans.com, whose directory indexes

materials appropriate for the needs and interests
of children. To perform a Yahoo! search, follow
these steps:

Step 1 Point your Web browser at www.yahoo.com; the Yahoo! home page appears.

Step 2 If you want to search all of Yahoo!, type your search term(s) into the blank search field
and click the Search button.

Step 3 If you want to search within a Yahoo! subject area, scroll down through the subjects
listed on the Yahoo! home page, and click the subject area you want—the Yahoo! subject
area page appears.

Step 4 If subtopics are listed on the subject area page, scroll down through the subtopics and
select the one you want. Repeat this process until you have narrowed the subject area of
your search.

Step 5 When you are ready to conduct a search, type your search term(s) into the blank
search field.

Step 6 Click the option to search all Yahoo! or just the subject area you have chosen.

Step 7 Click the Search button; Yahoo! performs the search and displays the items that match
your search terms.

Step 8 Scroll down through the matches to see what Yahoo! found. All the matches are hot-
linked; to see an item, click a highlighted word.

Step 9 If there are more matches to be displayed, you will find “Next 20 matches” printed at
the bottom of the search results. Click “Next 20 matches” if you want to see more.



Keyword Searching

Like subject-oriented directories, keyword search engines have spiders
that are constantly combing the Web and feeding information into a data-
base. Instead of organizing the Web according to subject areas, however,
keyword search engines let you search for keywords in documents, regard-
less of the subject of the documents. Therefore, keyword search engines
are likely to find more than subject-oriented searches, but what is found
may not be as relevant to your subject.

AltaVista

The AltaVista search engine was invented by the Digital Equipment Cor-
poration as the Web’s first full-text keyword search engine. Now a free-
standing company, AltaVista’s Web address is www.altavista.com.
AltaVista has been awarded more search-related patents than any other
company. According to Digital, AltaVista is the fastest search service avail-
able (0.4–0.5 seconds average response time), with the most up-to-date
content (refreshed every 28 days). When this book went to press,
AltaVista’s index included 350 million Web pages.

Because you are likely to get thousands of hits when you search
AltaVista for a keyword, AltaVista sorts the hits according to the relevance
or level of importance of the information found. This is done through sta-
tistical analysis that organizes pages with similar content into groups.

While conducting searches at the AltaVista site, you may notice that the
commercial ads that appear onscreen often relate to your keywords. This
is done by matching the content of the ads to the concept analysis of your
keywords. This kind of concept mapping is used at many commercial
search sites. Advertisers pay to have their ads come onscreen when some-
one conducts a search in the product’s concept area.

Advanced Boolean Searching

Boolean logic is named after the nineteenth-century mathematician
George Boole, who invented a form of algebra in which all values reduce to
either TRUE or FALSE. The Boolean operators AND, OR, and NOT are
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Step 10 By default, Yahoo! combines your search terms with the Boolean AND, which means
you will get a match only when all the search terms are found together in an item. If you
want a Boolean OR done instead, click the Advanced Search option that you see printed
next to the Search button.

Step 11 In addition to letting you perform the Boolean OR option by searching for “any of these
words,” the advanced options also let you search for an exact phrase. I find this very
helpful in troubleshooting technical problems. If some process gives you a cryptic error
message, for example, you can use the Yahoo! exact phrase option to search for that
reported error. Chances are someone else has already encountered this error and has
written on the Internet about how to solve the problem.



widely used in computer programming and in search engines to construct
queries that narrow a search to find precisely what you are looking for.
The simplest form of a Boolean query uses AND to find things that contain
two items that must be found together in the same document, such as

hot AND cold

Such a search will find fewer documents than the following search,
which is less exclusive:

hot OR cold

The opposite of that search is:

hot AND NOT cold

More complex searches can be done by using parentheses to create
more complex queries:

sunny AND NOT (hot OR cold)

To search for exact phrases, you can use quotation marks, as in

sunny AND NOT (“too hot” or “too cold”)
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Conducting a Boolean Search
Learning how to conduct a Boolean search will make you very powerful because the Boolean logic enables you
to narrow your search down to find just what you are looking for. The best way to learn to do a Boolean search
is to simply try one. Follow these steps:

1. Browse to www.altavista.com; the AltaVista home page appears.

2. Click the Advanced Search option to make the advanced search screen appear.

3. Click the option to search with a Boolean expression.

4. In the Boolean Expression field, type:
“Martin Luther”
Be sure to type the quote signs, which force the search engine to look for the words Martin and Luther
appearing next to each other. Click the Find button, and make note of the number of hits you get.

5. In the Boolean Expression field, type:
“Martin Luther” AND NOT “Martin Luther King”
Click the Find button, and make note of the number of hits you get. Can you explain why you get
fewer hits than when you searched for “Martin Luther” by itself?

6. In the Boolean Expression field, type:
“Martin Luther King” AND (“I Have a Dream” OR “Letter from a Birmingham Jail”)
Click the Find button. Notice that this search finds documents mentioning Martin Luther King and
either his famous I Have a Dream speech or his Letter from a Birmingham Jail.

7. Almost anything in the world you want to know is retrievable once you develop skill at using the
advanced search syntax. For more information about advanced searching, click the AltaVista Help
option and follow the link to free-form Boolean queries using special search terms.

Try This!



Concept Searching

Some users are better at keyword searching than others. Finding the right
combination of keywords and logical operators (AND, OR, NOT) to get a
search engine to find the kind of information you seek can be time-consuming
and tedious. Concept-oriented search engines can help users who have
difficulty with keyword searching.

Excite

Excite is a concept-based search engine that you will find at www.excite.com.
It uses a search technology called Excite Precision Search to analyze more
than 250 million Web pages in the Excite search index. Evaluations of link
authority and Web page popularity combine with text indexing, semantic
matching, and link analysis to select the most relevant and popular Web
pages that match your search query.

But Excite is much more than a search engine. It also provides customiz-
able newsfeeds and stock reports, shopping and weather, live chats and
bookmarks. Quick Tools include a personal address book, a calendar,
horoscopes, maps/directions, and yellow pages. Excite also offers a free
start page that includes e-mail, clubs, chat, and your own personal portfo-
lio. Perhaps even more than being a search engine, Excite wants to become
your personal portal to the Internet. To check out its wide range of Internet
services, go to www.excite.com.

Google

The Google search engine adds a new twist to searching by using an auto-
mated method that ranks relevant Web sites based on the link structure of
the Internet itself. When you conduct a search, Google sorts the results in
order of importance, based on how the site is linked to and referred to by
other sites. The assumption is that the more a site is linked, the more of an
authority it is. Google certainly takes a lot of Web pages into consider-
ation; when this book went to press, Google indexed more than three bil-
lion Web pages. To search them, go to www.google.com.

Metasearching

By now you may be getting overwhelmed by the number of search engines
and the subtle distinctions in how they work. Metasearching provides an
alternative to trying many individual search engines to find the informa-
tion you seek. Metasearching is the searching of searching, which you per-
form with a metasearch engine that invokes the other search engines
automatically. Behind the scenes, the metasearch engine conducts different
kinds of searches for you, collates the results into one list of hits, and re-
ports back to you.
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MetaCrawler

MetaCrawler conducts searches by sending your queries to several Web
search engines, including AltaVista, FindWhat, Yahoo!, Ask Jeeves,
LookSmart, Google, About, and Overture. MetaCrawler organizes the re-
sults into a uniform format and displays them in the order of the combined
confidence scores given to each reference by the services that return it. You
also have the option of scoring the hits, enabling what is found to be sorted in
a number of different ways, such as by date, locale, and organization.
MetaCrawler supports the advanced search syntax explained in the section
on Boolean searching. MetaCrawler is on the Web at www.metacrawler.com.

Dogpile

Research attorney Aaron Flin created Dogpile when he became frustrated
with finding too few results with subject-oriented directories such as Ya-
hoo!, and then trying keyword search engines such as AltaVista that re-
turned 30,000 or more documents in response to the same query. Dogpile
is a metasearch engine that sends your Web queries to the Internet’s top
search engines, including Google, Yahoo!, AltaVista, Ask Jeeves, About,
FAST, FindWhat, and LookSmart. Dogpile also searches FTP sites,
newsfeeds, yellow pages, white pages, classifieds, auctions, audio, and im-
age files. You can find Dogpile on the Web at www.dogpile.com.

CNET Search.com

CNET’s Search.com is a metasearch engine that searches more than 800
engines, including Yahoo!, AltaVista, Magellan, Lycos, Inktomi, Direct
Hit, and Snap. A special feature is the channel, which lets you customize
the search engines used to look for information in different content areas.
Channels include categories such as automotive, business, computing, en-
tertainment, government, music, people, shopping, and travel. To search
these channels and more, go to www.search.com.

Human-based Searching

When you do not have time to wade through the tens of thousands of doc-
uments that a keyword search engine can return in response to a search,
you may wish to consider using a human-based search service. A person
skilled in searching published information sources, proprietary databases,
and the Internet will find an answer and e-mail you the results.

Ask An Expert

Pitsco’s Ask An Expert site is a free searching service that connects you to
hundreds of real-world experts, ranging from astronauts to zookeepers.
You can ask questions in 14 different categories, including Science/Tech-
nology, Animals, Education, Career/Industry, Health, Internet/Computer,
Recreation/Entertainment, International/Cultural, Resources, Money/
Business, Arts/Humanities, Law, Home Improvement, and Repair/Trades.
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The answers come to you from real-world experts who have volun-
teered to answer your questions. The Ask An Expert site is on the Web at
www.askanexpert.com.

Scholarly Searching

One of the problems with searching for information on the Internet is that
the Web is a public resource. Anyone can create a Web page about any
topic, regardless of how much (or how little) the Web page author knows
about the subject. When you use a search engine such as AltaVista to find
information about that topic, the results contain a mix of pages written
by people who know a lot about what they are talking about along with
people who may not know much and may even write misleading or false
information.

One way of filtering out the bad information is to use a search engine
that restricts itself to scholarly information that has been published in ref-
ereed journals.

ERIC

ERIC stands for Educational Resources Information Center. The ERIC data-
base includes more than a million abstracts of articles from education jour-
nals and other scholarly documents, including books, conference
proceedings, symposia, studies, and
tests. Figure 2-15 illustrates access-
ing ERIC at www.eric.ed.gov, where
you can search the database by key-
word, author, title, or topic. If you
are unsure of your topic, you can use
the ERIC thesaurus to select a topic.

About.com

Formerly known as The Mining
Company, About.com takes a
unique approach to providing ac-
cess to scholarly sources. It hires
real scholars to serve as guides in
more than 700 subject areas. (I was
invited to be the educational tech-
nology guide, for example, but had
to decline due to other writing com-
mitments, such as this book.) The
guides at About.com organize the
links, keep them updated, write new
articles, host discussions and chats,
and answer questions online. To
find out more and to search your
subject area, go to www.about.com.
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FIGURE 2-15 The ERIC database at www.eric.ed.gov lets you freely search the world’s
largest source of educational information, which contains more than a

million abstracts of journal articles and education documents. �



Britannica.com

Britannica.com is a Web-based knowledge and learning center that in-
cludes the complete, online version of the Encyclopaedia Britannica. The
obvious advantage of the online version is that you have access to all the
latest information at once, without needing to conduct separate searches
through the 32 printed volumes and the annual Book of the Year. The on-
line version also includes hundreds of articles not found in the printed en-
cyclopedia, including selected articles from Newsweek, Discover, and The
Economist. There are also thousands of links to Web sites selected by Bri-
tannica editors.

To search the Encyclopaedia Britannica online, go to www.britannica
.com. Although you can search the encyclopedia for free, you must pay a
subscription fee to view the full text of encyclopedia articles over the
Internet. Free-trial subscriptions are available that permit you to try out
the service before you begin paying for it.

XanEdu

XanEdu offers access via the Web to thousands of publications indexed by
ProQuest, a global leader in the collection, organization, and distribution
of value-added information to researchers, faculty, and students in librar-
ies, government, universities, and schools in more than 160 countries. In
addition to providing a search tool for the entire ProQuest database,
XanEdu has created a ReSearch Engine for General Studies, Education,
and MBA business majors. These three ReSearch Engines provide access
to thousands of the world’s best newspapers, magazines, and scholarly
journals. The education engine keys these materials to education stan-
dards and textbooks. A special section on “Teaching as a Profession” helps
teachers keep up with the latest news and issues including school reform,
labor issues, and certification standards. For more information, visit
www.xanedu.com, where you can get a free trial subscription to try out the
service.

Multimedia Searches

Multimedia is becoming increasingly popular on the Internet. You can find
millions of pictures, audio files, animations, and videos to play on your
computer. The challenge is to find the ones you are interested in. Happily,
most of the search engines provide ways for you to search for multimedia.

Lycos Multimedia

At the Lycos Web site at www.lycos.com, you can click the multimedia op-
tion, or you can go directly to multimedia.lycos.com. After you enter your
keywords, select the kind of media you are looking for, and press the
Search button, the Lycos search engine returns a list of pictures, movies,
streams, or sounds dealing with your topic. You then preview the objects
and download the ones you want.
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If your intended use of a picture or a sound found on the Internet is not a
fair use, you will need to seek copyright permission by contacting the ad-
ministrator of the Web site where the object was found. Chapter 4 pro-
vides detailed information and guidelines regarding the fair use of
multimedia.

AltaVista Multimedia

AltaVista has a multimedia section where you can search for images, au-
dio, and video. The audio search includes the popular MP3 audio file for-
mat for sharing music over the Internet and downloading it to play on your
computer or a portable digital audio device. To perform a multimedia
search, go to www.altavista.com. Depending on what you are looking for,
click either Images, MP3/Audio, or Video.

With the Images search, you can look for photos, graphics, or buttons
and banners, either in color or in black and white. The audio search lets
you specify whether you want MP3, WAV, Windows Media, or Real au-
dio, lasting for more or less than a minute. The video search finds movies
lasting more or less than a minute in AVI, MPEG, QuickTime, Windows
Media, or Real video formats. You learn more about these file formats in
the last part of this chapter, which covers the types of files you are likely to
find when downloading from the Internet.

Singingfish

Singingfish specializes in the development and delivery of search engines
that can find streaming media content on the Web. Included is access to
music, news, movies, sports, TV, radio, finance, and live events.
Singingfish is a wholly owned subsidiary of Thomson multimedia. To
check out their services, or to conduct a multimedia search, go to
www.singingfish.com.

Newsgroup Searches

Newsgroups are a rich source of information about current research in
progress. Most disciplines have active newsgroups where current research
topics are discussed. Some of the keyword-oriented search engines dis-
cussed earlier in this chapter have options for searching newsgroups as
well as Web pages. AltaVista, Dogpile, Excite, Google, InfoSeek, and Ya-
hoo! all provide a newsgroup search option.

At groups.google.com, for example, you can perform keyword searches
of information written in more than 700 million USENET messages over
the past twenty years. The search terms can include the names of the peo-
ple who wrote the messages. You can also search only on a name, to get an
index of all the topics and messages a given person may have written in a
newsgroup.

Some users have expressed surprise upon learning that users can now
search through newsgroups and find out what has been written by specific
people about specific topics. Some consider this to be a retroactive inva-
sion of privacy. If you want to prevent messages you write in newsgroups
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from being visible to search engines, you must set the x-no-archive flag
when you write the message. You can set this flag by making the first line in
the body of your message read as follows:

L 2-1 x-no-archive: yes

File Searches

As you learned in Chapter 1, FTP stands for File Transfer Protocol. There
are millions of files you can download to your computer from FTP sites all
over the Internet. Many of these files are Web pages you can find with the
Web-based search engines discussed earlier in this chapter. Some files,
however, are not in Web page format. To find these other kinds of files, you
need to use a search engine that can do FTP file searches.

Archie

Archie is a search tool for FTP servers. It was written by the Archie Group
(Peter Deutsch, Alan Emtage, Bill Heelan, and Mike Parker) at McGill
University in Montreal, Canada. The name Archie is easy to remember be-
cause it is very close to the word archive, which refers to the collection of
files in the FTP database. The Archie program searches the names of the
files in this archive, which consists of the millions of files that are available
on anonymous FTP sites.

You can search the Archie database in two ways. You can either telnet to
a server that hosts the Archie program, or you can use an ArchiePlex,
which is a Web page that provides Web access to the Archie search engine.
Telnet is a network service that enables you to log on remotely to other
networks on the Internet. You will learn how to use telnet in Chapter 3.

Archie is a legacy tool that is waning in popularity as many other
Internet search engines have acquired more efficient ways of helping you
find the files you want. When this book went to press, there was a working
ArchiePlex at www.usgs.gov/Mosaic/cgi-bin/archie.html. To find others,
search Google or Yahoo! for ArchiePlex. To learn about the current status
of FTP searches, go to www.ftpsearchengines.com.

Gopher, Veronica, and Jughead

Another legacy tool on the Internet is Gopher, a protocol for organizing
information hierarchically on the Internet. Gopher was the rage in the
early 1990s, prior to the release of the graphical Web browser. Gopher was
invented in 1991 at the University of Minnesota, home of the Golden Go-
phers. Its function on the Internet is to help you “go fer” things; thus, the
term Gopher is a play on words. Some related tools are Veronica, a search
tool for finding Gopher files, and Jughead, which added keyword search
and Boolean operator capabilities to Gopher search. Veronica was
Archie’s girlfriend in the classic Jughead comic strip. As an acronym, Ve-
ronica stands for Very Easy Rodent-Oriented Net-wide Index to Comput-
erized Archives, and Jughead stands for Jonzy’s Universal Gopher
Hierarchy Excavation and Display.
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Although the Gopher is used little in actual practice today, it earned its
place in history as one of the first killer applications on the Internet. Al-
though most people who used the Internet in the early 1990s used the Go-
pher, hardly anyone uses it today. To find out about its current status, go to
www.searchenginewatch.com and search for Gopher.

Download.com

CNET’s Download.com is a handy site for finding and downloading
useful files to your computer. The file categories include MP3/audio,
business/finance, desktop enhancements, development tools, games,
Internet, multimedia/design, Web authoring, utilities, and drivers. The
menus make it easy to drill down to the file you want to download.
There are in-depth reviews and spotlight articles highlighting featured
downloads of the day. To peruse the latest list of downloads, go to
download.com.

How to Find People

In addition to helping you find Web pages, newsgroups, files, and schol-
arly documents, the Internet can also help you locate people.

Bigfoot

Located at www.bigfoot.com, Bigfoot offers a huge catalog of e-mail ad-
dresses and white page directories. These catalogs enable you to search for
someone’s e-mail address or white-page street address.

WhoWhere

WhoWhere lets you look up e-mail addresses, residential listings, toll-free
800 numbers, and millions of businesses, including maps and directions.
Now that WhoWhere has become part of the Lycos network, you will find
WhoWhere at www.whowhere.lycos.com.

Switchboard

You can use the Switchboard white pages service to find people and busi-
nesses. It handles more than 5 million lookups for people and businesses
each week. You can find Switchboard at www.switchboard.com.

People.yahoo.com

There is a free online white pages search and listing service at people.yahoo
.com. You can search by the person’s name, city, or state to find out the per-
son’s e-mail address or street address. You can also search thousands of
public databases with one click to find addresses, property records, licenses,
and court records.
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Finding Places

Have you ever gotten lost when driving somewhere? Have you encoun-
tered road closings or construction delays that you wish you had known
about in advance? The next time you plan a trip, treat yourself by getting a
map and a list of specific driving instructions before you take to the roads.

MapQuest

You can visit the most popular interactive mapping service on the Web at
www.mapquest.com. MapQuest can help you find more than three mil-
lion locations worldwide, print driving directions, and create and save per-
sonalized maps. Live traffic updates are a popular feature that can save
you time when roads close or traffic snarls.

As one of the busiest sites on the Internet, MapQuest serves on the aver-
age more than 10 million maps per day. MapQuest’s tools provide maps
and directions tailored to different types of travelers. MapQuest’s clients
include Yahoo!, Lycos, the National Geographic Society, the American
Auto Association, Fodor’s, and many yellow page directories. As a per-
sonal user of MapQuest, I can attest to the quality and accuracy of its maps
and driving instructions. Best of all, MapQuest is free.

Finding Legal Information

If you know where to look, the Web is an excellent source of legal informa-
tion. By visiting the sites that follow, you will see why the Web has become
the legal profession’s primary source of news and information.

Law.com

American Lawyer Media (ALM) is one of the leading sources of news and
information for the legal industry in the United States. ALM sponsors a
Web site at Law.com, where many legal professionals go to get their news.
The search engine at Law.com enables you to search the wire services for
news about current legal cases. You can also read or search the full text of
more than 20 legal publications, including The National Law Journal, The
American Lawyer, New York Law Journal, and Legal Times. To peruse
these and other ALM services, go to www.law.com.

FindLaw

True to its name, the FindLaw site enables you to search for all kinds of le-
gal information. It can also match you up with a lawyer, if you need legal
help or advice. FindLaw has channels for legal news, professionals, stu-
dents, businesses, and the public at large. The search engine enables you to
perform keyword searches of the U.S. Constitution, the Supreme Court,
government sites, legal sites, the legal news channel, a legal dictionary,
and an online library of legal articles. To visit the FindLaw site, go to
www.findlaw.com.
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LexisONE

Sponsored by LexisNexis, the LexisONE Web site brands itself as “The
Resource for Small Law Firms.” It features a free legal headline news ser-
vice and provides free keyword searches of the news, case law, and legal
forms. To perform these free searches, however, you must first register at
the site. To do so, go to www.lexisone.com. To find out about other
LexisNexis services, go to www.lexisnexis.com.

Index of Collected Search Engines

Search engines are undergoing a lot of research and development on the
Internet. By the time you read this, new search engines will be announced
that were not available when this book went to press. You can use Yahoo!
to find the latest information about new search engines and what they do.
At www.yahoo.com, go to the section on Computers and Internet, and do
a search for the keyword search.

Another good place to learn about search engines is the Search Engine
Watch, where you will find announcements of the latest search services
and Web searching tips. Hosted by Internet.com, you will find the Search
Engine Watch at searchenginewatch.internet.com.

Adding a Web Site to a Search Engine

In Part II of this book, you learn how to create a Web site and publish it on
the Internet. Automatically, spiders will begin finding your site and listing
it in selected search indexes. There is no guarantee, however, that your site
will be listed by all the search engines. To help ensure that it gets included
in a certain index, you can go to the desired search engine site and follow
that site’s procedure for adding your site to its search engine. Here are
some examples:

� Yahoo! At www.yahoo.com, go to the appropriate subject
category and click the option to Suggest a Site. You will get an
online form to fill out and submit, along with an explanation of
how much it will cost to list your site.

� AltaVista At www.altavista.com, near the bottom of the page,
click the menu option to Submit a Site. You will get a screen
explaining the different listing services. The free service is called
Basic Submit; the other services cost money. The amount you
spend will depend on the level to which you want AltaVista to
promote your site.

� Lycos At www.lycos.com, click Site Submit to bring up the search
engine submission screen. Follow the links to learn about the different
kinds of site listings and ad services that are available. There is a free
site submission option, but you must register to use it.
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� bCentral There is a Web page listing service at www.bcentral.com
called Submit It, where you can submit Web pages to about 400
different search engines and indexes. You pay an annual fee for this
listing service. To check it out, go to www.bcentral.com and follow
the link to Search Engine Submissions.

Downloading from the Internet

You need to know how to download five basic types of files from the
Internet, namely, text, graphics, audio, video, and software. After showing
you how to download and handle these files, this chapter concludes by
teaching you how to download and unpack a zipped (i.e., compressed) ar-
chive, which can contain any combination of these five file types.

Commonly Found Text File Formats

There are three families of text formats: plaintext, hypertext, and word pro-
cessor files. Plaintext means just that—the text and nothing but the text. Hy-
pertext contains the text intermingled with markup codes called tags that
determine how the text is to appear and which words in the text serve as
triggers that launch things when clicked. Word processors such as Microsoft
Word and WordPerfect use proprietary formatting to encode the text and its
properties, including font, size, margins, borders, headings, and pagination.
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Step-by-Step 2-4
Downloading Text from the Internet
The quickest way to download text from the
Internet is to copy the text onto your computer’s
Clipboard, from which you can paste the text into

any other window on your screen. To perform
this copy-and-paste method of downloading
text from the Internet, follow these steps:

Step 1 Use your browser to display the text you want to download.

Step 2 Drag your mouse to select the text you want to copy; the selected text appears
highlighted. Or, if you want to select all the text on the Web page, pull down the
browser’s Edit menu and choose Select All.

Step 3 Press the Copy keys (CTRL-C on Windows or COMMAND-C on a Macintosh) or pull
down the Edit menu and choose Copy.

Step 4 If the application into which you want to paste the text is not already running, get it
running now.

Step 5 Position your cursor at the spot in the window to which you want to want to paste the text.

Step 6 Press the Paste keys (CTRL-V on Windows or �-V on a Macintosh) or pull down the
application’s Edit menu and choose Paste.



TXT (PlainText)

Plaintext files are identified by the filename extension .txt. When you see a
filename such as history.txt, you know it is a plaintext file because of its
.txt filename extension. In computer jargon, plaintext files are known as
ASCII files. ASCII (pronounced askee) stands for American Standard
Code for Information Interchange. Every text editor and word processor
has an option for reading and writing files in ASCII format. Sometimes the
format is called plaintext or DOS text instead of ASCII text.

Because plaintext files are so common on the Internet, the Web browsers
have a built-in ability to display them. To download a copy of a plain-text
file you are viewing with a Web browser, simply pull down the browser’s
File menu, choose Save As, and use the Save controls to save a copy in the
plain text file format.

HTML (Hypertext)

HTML stands for hypertext
markup language. Files in HTML
format have the filename extension
.html or .htm. HTML is the most
prevalent file format on the World
Wide Web, because most Web
pages are encoded in HTML. True
to its name, an HTML file contains
the text that gets displayed on a
Web page, along with special codes
known as markup that define
(1) how the text should appear on-
screen, (2) which words in the text
are hyper, and (3) what gets trig-
gered when the user clicks the hy-
pertext. For example, Figure 2-16
shows how a Web page displays an
HTML file, and Figure 2-17 shows
how the same file appears when
viewed with a text editor. The
codes inside <brackets> are the
markup that tells the Web browser
how to interpret the text. You learn
more about the HTML codes in the
Web page creation tutorial in Part II
of this book.

Whenever you want to down-
load a Web page that you are view-
ing with your Web browser, simply
pull down the browser’s File menu,
choose Save As, and use the Save
controls to save a copy in the
HTML format.
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FIGURE 2-16 The State of the Union Address as viewed with a Web browser �

FIGURE 2-17 The State of the Union Address as viewed with a text editor �
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DOC (Microsoft Word) and WPD (WordPerfect)

Among the many word processor formats, the most common are
Microsoft Word’s DOC format and WordPerfect’s WPD format. DOC
stands for document, and WPD stands for WordPerfect document. Web
browsers do not usually contain built-in support for word processor file
formats. Instead, your browser calls on a helper application to display the
file on demand. There are two ways to download this kind of file. First,
you can wait for the helper app to display the file, pull down the helper
app’s File menu, and use the Save option to make yourself a local copy of
the file. Second, you can right-click (Windows) or CONTROL-click
(Macintosh) the link that otherwise launches the file. When the quick
menu pops out, choose the option to save the file.

Portable Document Format (PDF)

Adobe realizes that a huge amount of printed text is not yet accessible on
the Web. To provide a way to digitize printed text into a format that can be
viewed on any computer platform, Adobe created the Portable Document
Format (PDF), for which the filename extension is .pdf. A quick way of
creating PDF files is to scan printed documents into your word processor.
If you have a lot of pages to scan, you can use a sheet feeder to speed the
scanning process. Then you can print the scanned pages to a PDF file.

You view PDF files with the Adobe Acrobat Reader, a free plug-in that
any user can get from the Adobe Web site. You will make some pretty
amazing discoveries when you use the Adobe Acrobat Reader to view a
PDF document. Because you are looking at what appears to be pictures of
the original document, you do not expect to be able to select, copy, paste,
and search for text as you could on a regular Web page. You will be pleas-
antly surprised to find, however, that all these functions are available un-
less the author disabled them. Perhaps your biggest surprise will come
when you choose to print the document. Instead of printing the bitmap
version of the image you see onscreen, Acrobat prints the document using
the fonts on your printer. As a result, the printed version may appear better
than the original.

To learn more about the PDF file format, go to www.adobe.com and
follow the link to Adobe PDF.

Commonly Found Graphics File Formats

The computer industry has produced so many graphics formats (more
than 30 at last count) that there is no true standard across the industry.
Table 2-3 lists a few of the more popular graphics file formats and de-
scribes what they are used for. On the Web, however, there are only two
file formats that every Web browser can be guaranteed to support: GIF
and JPEG.
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Step-by-Step 2-5
Downloading Images from the Internet
The quickest way to download an image from the
Internet is to use your Web browser’s option for
saving the image to a file. When you save the image
to a file, you have the option of changing its name.
If you change the filename, make sure you keep
the filename extension the same as the original
filename’s, because that is how other programs
recognize it as the type of file it is. For example, if the
image you are saving is in GIF format, make sure the
filename extension on the file to be saved is .gif.

If the image you are saving is in JPEG format,
make sure the filename extension on the file to
be saved is .jpg. Renaming the filename extension
of a .gif file to .jpg does not change the format
of the file. If you want to change the format of
the file, you must use a file-conversion program
such as Paint Shop Pro, which you learn how to
use in Chapter 6. To download an image from
the Internet, follow these steps:

Step 1 Use your browser to display the image you want to download.

Step 2 Right-click (Windows) or CONTROL-click (Macintosh) the image you want to download,
and a menu will pop out. On a Mac, you can also trigger the menu by holding down the
mouse button until the menu pops out.

Step 3 The popout menu provides you with options you can do with the image; choose the
option to “Save image as” or “Save picture as.” The Save As dialog appears.

Step 4 In the File name field, you should see the name of the file this image has on the Internet.
You can change the name if you want, but make sure you leave the filename extension
the same as in the original.

Filename
Extension

Intended Purpose

.bmp Windows bitmap. The .bmp file is the most efficient format to use with Windows.

.gif Graphics Interchange Format. Invented by CompuServe for use on computer networks, GIF is the most prevalent
graphics format for images on the World Wide Web.

.pcd Kodak’s Photo CD graphics file format; contains five different sizes of each picture, from “wallet” size to “poster” size.

.jpg or .jpeg JPEG image, named for the standards committee that formed it: Joint Photographic Experts Group. Intended to
become a platform-independent graphics format, this is arguably the best choice for publishing full-color
photographs on the Web.

.pict Macintosh graphics format.

.png Portable Network Graphics format. Pronounced ping, PNG is the patent- and license-free format approved by the
W3C (World Wide Web Consortium) to replace the patented GIF format. Because the PNG format is not yet fully
supported by all browsers, Web authors typically convert graphics to GIF or JPEG for use on Web pages.

.tga Truevision Targa format; tga stands for Targa, which is a video capture board.

.tif TIFF file; stands for Tagged Image File Format. Known as “the variable standard” because there are so many kinds of
TIFF subformats.

.wpg WordPerfect graphics format.

TABLE 2-3 The Most Common Computer Graphics Formats �



GIF

GIF stands for Graphics Interchange Format. Invented by CompuServe
for use on computer networks, GIF is highly efficient. Instead of contain-
ing the RGB (red, green, blue) value of every pixel (picture element) in the
image, a GIF file contains a table defining the different pixel patterns
found in the image, with pointers into the table indicating where the pat-
terns go onscreen. It is important to understand that although GIF files are
compressed, none of the original information in the graphic gets lost in the
compression process. The decompressed image you see onscreen is exactly
the same as the one that got compressed into the GIF file. Because nothing
gets lost, this kind of encoding process is known as lossless compression.
GIF files are limited to a palette of 256 colors; however, if you need more
than 256 different colors in a picture, you should use the JPEG format.

JPEG

JPEG (pronounced Jay-peg) stands for Joint Photographic Experts Group,
which is the name of the international standards committee that created it.
JPEG was invented as a platform-independent graphics format. JPEG im-
ages can contain millions of colors, whereas GIF images are limited to a pal-
ette of 256 colors. JPEG uses a lossy compression algorithm to reduce the
amount of space it would otherwise require to store so many colors. Lossy
means that some of the image data can become lost, depending on how
much compression is used when the image gets saved. JPEG compresses the
image by dividing it into tiny cubes and averaging the color values within the
cubes. Most people are unable to notice the tiny cubes in the image. One of
the settings you can vary when saving a JPEG image is the size of the cubes.
The larger the cubes, the more compression you will get, but the cubes will
also be more noticeable.

PNG

The World Wide Web Consortium is working on a new graphics format
called Portable Network Graphics (PNG). The goal is to create a fast,
lossless, patent-free file format that can handle pictures containing up to
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Step 5 You can use the Save As dialog to navigate to a different drive or folder on your computer,
or you can type a complete path onto the beginning of the filename to specify exactly
where you want the image file to be saved on your computer.

Step 6 Click the Save button when you are ready to save the file.

Warning: Although you can easily download files from the Web, you should not do so
without permission. Under U.S. copyright law, Web content is the legal property of its
author and is not automatically free for the taking. Unless the material is in the common
domain or is clearly marked as being free, you may need to seek permission to use it
lawfully in other works. Chapter 4 provides you with guidelines for determining when
you need to ask for permission.



48 bits of color information per pixel. The screen captures in this book, for
example, were transmitted in PNG format from my PC to the publisher’s
Macintosh. You can monitor the progress of the creation of PNG at
www.w3.org/Graphics/PNG.
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Downloading a Picture from the Internet
Now that you have completed the section on images and graphical file formats, this would be a good time to
test your ability to download a picture from the Internet. The Library of Congress Web site, for example, has
many interesting pictures. Follow these steps:

1. Use your Web browser to go to www.loc.gov, and download one of the pictures to your computer.
If you have trouble, refer to the instructions in the previous section, “Downloading Images from the
Internet.”

2. If you change the filename before you save the file, make sure the filename extension of the file you
save matches the filename extension of the original.

3. Use the Windows Explorer or the Macintosh Finder to locate the file you saved in the preceding
step, and double-click the file to launch it.

4. If the image appears properly, you have succeeded in learning how to download images to your
computer; congratulations! If your computer tells you there is no program available to display the
image, follow the steps in Chapter 6 to install Paint Shop Pro.

Cross
Check

Step-by-Step 2-6
Downloading Audio and Video from the Internet
To download audio and video, you follow a process
very similar to the method you learned earlier for
downloading graphics. You right-click (Windows)
or CONTROL-click (Macintosh) on the link that

triggers the audio or video, and you use the
quick menu to save a local copy on your
computer. Detailed instructions are provided
as follows:

Step 1 Use your browser to display the link that triggers the audio or video you want to
download.

Step 2 Right-click (Windows) or CONTROL-click (Macintosh) the trigger. A pop-up menu
provides you with options you can do with the object linked to the trigger; choose the
“Save link as” or “Save target as” option to make the Save As dialog appear.

Step 3 In the File name field, you should see the name of the file that this object has on the
Internet. You can change the name if you want, but make sure you leave the filename
extension the same as in the original.

Step 4 Click the Save button when you are ready to save the file.



Commonly Found Audiovisual File Formats

Every sound has a waveform that describes its frequency, amplitude, and
harmonic content. Waveform audio digitizers capture sound by sampling
this waveform thousands of times per second; the samples are stored in a
computer file. Figure 2-18 shows a waveform in the process of being sam-
pled. For each sample, a number gets written into the corresponding wave-
form audio file. The number tells how far the sample rose above or fell
below the zero amplitude line. When you click to play the file, the samples
play back through your computer’s sound chip, and you hear the wave-
form audio. Waveform audio can be transmitted over the Net in several file
formats.

WAV

On computers running Windows, the native waveform audio filename ex-
tension is .wav, which stands for waveform. When the Web started, you
needed helper applications to play audio, because the first browsers lacked
built-in support for .wav files. Happily, all the major browsers now con-
tain native support for playing .wav files, on Macintosh as well as Win-
dows operating systems.

AU and SND

The Sun audio format filename extension is .au, and .snd is the audio format
that started on the NeXT workstation. These formats are essentially the
same except that .au files do not have file headers to specify different sam-
pling rates and compression formats. Thus an .au file gets recorded and
played back at a “standard” rate, whereas .snd files can have different set-
tings, depending on the nature of the sound and the purpose of the record-
ing. The Macintosh has built-in support for .snd files. On the Java platform,

.au is the native audio format.

RA and RAM

Real-time audio streaming used in
Internet radio broadcasts requires
a special file format optimized for
real-time transmission over the
Internet. The RealAudio filename
extensions are .ra and .ram, which
stand for RealAudio metafile. A
RealAudio metafile is a text file
that contains the Web address
(URL) of a RealAudio fi le .
RealAudio files cannot be refer-
enced directly by the Web page be-
cause this would cause them to be
downloaded in their entirety be-
fore playback. For a RealAudio file
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FIGURE 2-18 A waveform in the process of being sampled; the vertical lines show the
points at which samples are taken. Follow along the timeline, and imagine

a number being written into a sound file to indicate how far each sample is above or below the
zero line. That is how the process of sampling works. �



to be played in real time, it must be played through a RealAudio player and
served by a RealAudio server. To accomplish this, you need a link between
the Web server and the RealAudio server. The link is contained in the
metafile.

AIF, AIFF, AIFC

AIFF stands for Audio Interchange File Format. Apple invented this file
format to create and play audio files on the Macintosh. AIFC is a com-
pressed version; the C stands for compressed. When you find an AIF file on
the Web, chances are it was recorded on a Macintosh.

MP3

MP3 is one of the most popular audio formats on the Internet. MP3 stands
for MPEG audio layer 3. It is an audio file format that uses an MPEG au-
dio codec to encode (compress) and decode (decompress) recorded music.
MP3 can compress a CD audio track into a substantially smaller file re-
quiring significantly less bandwidth (about 10 percent) to transmit over
the Internet, without degrading the original sound track’s quality.

To download a free MP3 player, find MP3 Web sites, and create MP3
files from your favorite audio CD, follow this book’s Web site links to
MP3. If you do not personally own the CD and/or if the MP3 files are not
for your own personal use, please observe the copyright and fair use guide-
lines presented in Chapter 4. Because the MP3 technology makes copy-
right violation so easy, the kind of software used to create an MP3 file from
an audio CD is called a ripper. Please be aware, however, that MP3 has
many legitimate uses on the Web. Some recording artists are choosing to
distribute their own songs in the MP3 format, for example, and some hit
songs have appeared in MP3 format first before being distributed on CD.
Little known artists use MP3 as a way to gain fans who may eventually
want to hear them in concert or buy their CDs.

MIDI Synthesizer Format (MID)

Musical Instrument Digital Interface (MIDI) is a music synthesizer file for-
mat that requires very little bandwidth to transmit because the sound chip
inside your multimedia PC does the work of generating the waveform you
hear. What gets transmitted is the performance information required for
your computer’s sound chip to play the music. Accordingly, a MIDI file
consists of a stream of codes that tells your computer when to turn notes
on and off, how loud to make them, what instrument should make the
sound (such as trumpet, flute, or drum), and whether to bend the notes or
add other special effects. Compared to the amount of storage required for
waveform audio recordings, MIDI takes up so little space that it is a very
popular format for transmitting music over the Internet. MIDI files have a
.mid filename extension.

This book’s Web site provides some incredible indexes of MIDI files you
can listen to. Follow the links to the MIDI archives, and you will get a list of
indexes that contain thousands of songs in a wide variety of styles, ranging

Chapter 2: Surfing and Searching the Internet



from classical to modern and from funk to rock. You will also find music
listed by artist, from Abba to Frank Zappa. You need to realize, however,
that MIDI does not record the singer’s voice. Thus, you will hear the synthe-
sized instruments, but you will not hear the lyrics.

Video Formats

When a movie is digitized into a computer file, the digital data stream is
enormous. To conserve file space and thereby reduce the bandwidth re-
quired to transmit the movie, the video gets compressed, down to as little
as 1/200th of its original size. One or more of the video compression
schemes explained in Table 2-4 may be used.

AVI

The most common video format in the Windows world is Microsoft’s AVI,
which has the .avi filename extension. AVI stands for audio/video inter-
leave, a clever scheme in which audio frames are interleaved with the
video. The sound track plays without interruption because the audio al-
ways takes priority. Then your computer shows as many frames of video as
it has time to process. If it is too late to show a given frame, the player just
skips it and goes on to the next frame. Because the audio has priority, you
get the aural illusion of uninterrupted playback.

MOV and QT

One of Apple Computer Corpora-
tion’s greatest gifts to the field of
multimedia is the QuickTime au-
dio/video format. QuickTime is so
robust and popular that it exists in
both Macintosh and Windows ver-
sions. Because of its cross-platform
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MIDI vs. Wave
Imagine a situation in which you have a waveform audio recording of a
symphony orchestra playing a piece of classical music and a MIDI file of
the same composition. Which file will take more time to transfer from
the Web to your computer? To help you answer this exercise, there is a
Waveform audio file and a MIDI file for you to compare at this book’s
Web site. Follow the links to MIDI versus Wave, and listen to the two
files. Both files are the same size, 17 kilobytes. Which one lasts longer?
How do you explain the difference in the length of the music you hear,
when the file size is the same?

Cross
Check

Method How It Works

YUV subsampling Divides the screen into little squares and averages color
values of the pixels in each square.

Delta-frame encoding Shrinks data by storing only the information that changes
between frames; for example, if the background scene does
not change, there is no need to store the scene again.

Run-length encoding Detects a “run” of identical pixels and encodes how many
occur instead of recording individual pixels.

TABLE 2-4 Video Compression Schemes �



capabilities, QuickTime has become very popular on the Internet. The file-
name extensions of QuickTime movies are .qt and .mov. For the latest in-
formation, go to www.apple.com/quicktime.

MPG, MPEG, and MPE

MPEG is emerging as the digital video standard for the United States and
most of the world. MPEG stands for Motion Picture Experts Group, the
International Standards Organization committee that created the stan-
dard. Endorsed by more than 70 companies, including IBM, Apple, JVC,
Philips, Sony, and Matsushita, MPEG compresses video by using a discrete
cosine transform algorithm to eliminate redundant data in blocks of pixels
on the screen. MPEG compresses the video further by recording only
changes from frame to frame; this is known as delta-frame encoding.
MPEG is becoming the digital video standard for compact discs, DVD, ca-
ble TV, direct satellite broadcast, and high-definition television (HDTV).

Four versions of MPEG have been worked on:

� MPEG-1 is the noninterlaced version designed for playback from
CD-ROMs.

� MPEG-2 is the interlaced version intended for the all-digital
transmission of broadcast-quality TV. Adopted by the U.S.
Grand Alliance HDTV specification, the European Digital Video
Broadcasting Group, and the Digital Versatile Disc (DVD-ROM)
consortium, MPEG-2 features surround sound. RCA’s DirecTV
service uses MPEG-2.

� MPEG-3 was to be the HDTV version of MPEG, but then it was
discovered that the MPEG-2 syntax could fulfill that need by
simply scaling the bit rate, obviating the need for the third phase.

� MPEG-4 is a low-bit-rate version of MPEG that is being invented
for transmitting movies over mobile and wireless communications.

For more information, follow this book’s Web site links to MPEG.

RM

One of the greatest challenges on the Internet is to deliver to your PC full-
motion video in an uninterrupted real-time data stream. First to market
with a product that does this was RealNetworks, the same company that
brought you the RealAudio technology discussed earlier in this chapter.
The name of the product is RealVideo, and the filename extension is .rm,
which stands for Real metafile.

RealVideo follows the Real Time Streaming Protocol (RTSP) that
RealNetworks invented for streaming audio and video over the Internet.
To read about this and other technical details, go to www.rtsp.org.
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Downloading Software and Data from the Internet

To download software and data from the Internet, you should begin by
reading any special instructions that might appear onscreen explaining
what will happen when you trigger the download. Almost all these instruc-
tions fall into one of three categories: documents, archived files, and self-
extracting archives. Each kind is discussed in turn as follows.

Documents

When a document is linked to a Web page, you have two options. You can
either click to view the document or, if you want to download it, you can
right-click (Windows) or CONTROL-click (Macintosh) the link to pop out
the menu that lets you save the document on your computer. The biggest
problem beginners report is knowing where to save the downloaded docu-
ment. If you have Windows, a good place is the folder called My Docu-
ments or My Downloads. On the Macintosh, beginners normally
download a document onto the desktop, from which you can move it later
to another folder if you want to file it away.

To download the document your Web browser is currently displaying,
you pull down the browser’s File menu, choose Save As, and use the Save
dialog to save the file to a folder on your computer’s hard drive. As always,
please remember not to alter the filename extension when you save the file.
If the file has a .doc filename extension, for example, do not change it to a
.txt filename extension. Remember that your computer looks at the file-
name extension to determine what application will handle the file. Re-
naming the filename extension will confuse your computer when someone
tries to access the file.

Compressed Archives

A popular method of distributing software and data over the Internet is via
archived files. An archive is a container into which one or more files has
been compressed to save space and packed into a single file that can be
transmitted easily over a network. When you receive such a file, you need
to use an extractor to unpack the archive and restore its contents onto your
computer. Windows users normally unpack archived files with a product
known as PKZIP for Windows or with a similar product such as WinZip,
NetZip, or EasyZip. Macintosh users unpack archived files with Stuffit
Expander, which is also available in a Windows version. Each of these
products is described as follows.

PKZIP for Windows PKWARE, Inc., is the industry leader in compres-
sion and decompression technology. Their product, PKZIP for Windows,
takes its name from the .zip filename extension that archived files nor-
mally have on Windows-based machines. PKZIP for Windows makes it
easy to zip and unzip files. After you download a zipped file from the
Internet, you simply open it with PKZIP for Windows. As illustrated in
Figure 2-19, PKZIP for Windows displays the contents of the zipped file.
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PKZIP for Windows is shareware, meaning you can download it for
free, try it out for a limited time period (usually 30 to 60 days), and then,
if you decide to keep using it, pay a reasonable fee (usually $29 to $39)
to the vendor. To download a copy of PKZIP for Windows, go to
www.pkware.com. If you have Windows XP, however, you may also wish
to consider using the zipped option that is built in to the Windows XP File
Manager. To learn about the built-in zipped option, click the Windows XP
Start button, click Help, and search for the following phrase: zipped com-
pressed folder. Installing PKZIP for Windows replaces the built-in Win-
dows XP support with PKZIP support.

Stuffit Expander On the Macintosh, compressed archives are handled
with a freeware program from Aladdin Systems called Stuffit Expander,
which is also available in Windows and Linux versions. True to its name,
Stuffit Expander can extract files from archives you download from the
Internet. If you are using a Macintosh and you do not have Stuffit Ex-
pander, you can download it for free from www.stuffit.com.

When you ask Stuffit Expander to expand a file, it opens a new folder
on the desktop and decompresses each file into that folder. As the files are
expanded, a status bar shows the progress of the decompression. When
Stuffit Expander is finished extracting the files of many applications, you
need only to click the app’s icon in the new folder to make it run. Other
apps create an install program that you must run separately to set up the
application.

Self-Extracting Archives

Another popular method of distributing software and data on the Internet
is the self-extracting archive, which is a compressed executable file into
which the files that comprise an application or set of data have been
packed. On the Windows operating system, self-extracting archives typically
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FIGURE 2-19 When you open a .zip file, PKZIP for Windows displays the contents of the
zipped archive. To expand the files into their original uncompressed format, you

pull down the Extract menu, choose Extract Files, and follow the onscreen instructions to save the files
in the folder of your choice. �



have the .exe executable filename extension. After you download a self-
extracting archive to your computer, you simply run the archive to unpack
the files and store them on your computer.

Most of the downloads at the CNET download.com site are distributed
in self-extracting archives. When you click to download one of them, your
browser asks whether you want to save the archive to disk or open it di-
rectly from the Web. If you choose the option to save to disk, a Save dialog
appears. Use the Save dialog to save the archive in the folder of your
choice, such as your computer’s temp folder. Then run the self-extracting
archive. If the archive’s icon is not visible, follow these steps to start a pro-
gram when its icon is not visible:

For Windows

1. Click the Windows Start button and choose Run to make the Run
dialog appear.

2. Click the Browse button; the Browse dialog appears.

3. Use the browse controls to select the filename of the program you
want to run.

4. Click Open; the filename of the program to be run appears in the
Open field of the Run dialog.

5. Click OK to run the file.

6. If you are unable to locate the file by using this method, click the
Windows Start button and use Search to locate the file. Then
double-click the file to run it.

For Macintosh

1. If you have OS X, get Sherlock running by clicking Sherlock in the
Dock. Set the option to search for Applications, enter the name of
the program you are looking for, and click the find button.

2. Otherwise, click the Apple icon in the upper-left corner of the
screen to pull down the menu, and then choose Find File.

3. Set the two drop-down menus to “Name” and “Contains” if they
do not say that already.

4. In the blank field, type the name of the program you are looking for.

5. Press the Find button to make your computer find the file.

6. Double-click the file to run it.

To conserve space on your computer’s hard disk after you run the self-
extracting archive, you can delete the archive after extracting the files from it.

Safeguarding Against Viruses

Unfortunately, some geeks get their jollies from finding ways to send peo-
ple viruses over the Internet. When you open files that you get from the
Internet, you run the risk of infecting your computer with viruses that can
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attach or embed themselves in certain kinds of files. The most vulnerable
types of files are the executables, which cause code to run on your com-
puter. Before you download an executable file, you need to check carefully
the source from which you are downloading it. If the file is coming from a
reputable site, such as Microsoft or Netscape or CNET’s download.com,
the file is most probably virus-free. The executable filename extensions to
be most careful about are .exe, .bat, .vbs, and .class. Viruses can also be
transmitted through macros in .doc and .xls files.

Whenever you download files from the Internet, you should run a virus
scan on your computer to make sure you have not received a virus. You can
make virus-scanning happen automatically if you set your antivirus soft-
ware to scan incoming and outgoing mail and file transfers. It is important
to remove viruses promptly, because letting them remain on your com-
puter can cause disruptive things to happen, such as files disappearing, un-
wanted messages coming onscreen, software acting strangely, and even
your entire hard disk losing its contents. Make sure your virus scanner is
up-to-date so it will recognize the latest viruses. When a new virus hits the
Net, updates are normally available within the day, and you should install
the update promptly. For the latest information about viruses and how to
remove them from your computer, go to antivirus.about.com,
www.mcafee.com, and www.sarc.com.
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Chapter 2 Review

■ Chapter Summary
After reading this chapter and completing the step-
by-step tutorials and Try This! exercises, you should
understand the following facts about connecting to
the Internet, surfing the Web, and finding what you
are looking for:

Getting Connected

■ To connect to the Internet, you must have six
things: (1) an Internet-ready computer that has
(2) an operating system with (3) TCP/IP installed,
along with (4) client software you use to access
the Internet over (5) an Internet connection that
connects you physically to the (6) Internet address
of your targeted service or resource.

■ The speed at which you connect to the Internet
determines bandwidth, which is the amount of
information your computer can send and receive.

■ Users who connect to the Internet via plain old
telephone service (POTS) must have a modem.
Named by a combination of the first syllable
from the terms modulate and demodulate, the
modem is a communications device that enables a
computer to send and receive digital information
over analog phone lines. Many computers have
modems built in.

■ The Point to Point Protocol (PPP) is the telephone
modem protocol of choice, because PPP supports
not only TCP/IP but also NetBEUI and IPX/SPX.
An older Serial Line Internet Protocol (SLIP)
supports only TCP/IP and requires a preassigned
IP address.

■ Ethernet is a high-speed local area network (LAN)
standard that is widely used across industry and
academia. Originally requiring coaxial cables,
Ethernet now can use category 5 twisted-pair
telephone wiring in a so-called 10BaseT
configuration. A faster 10/100BaseT Ethernet
can move data at rates up to 100 megabits per
second. There is also a 10 gigabit Ethernet
standard known as 10GbE.

■ The Integrated Services Digital Network (ISDN) is
the digital telephone system that the regional Bell
companies are installing in most of the United

States. The Basic Rate Interface (BRI) service of
ISDN is 144 Kbps, made up of two 64-Kbps data
channels and one 16-Kbps control channel. The
Primary Rate Interface (PRI) service uses 23 data
channels and a 64-Kbps control channel to boost
the data rate to 1,544 Kbps (1.544 Mbps).

■ A cable modem is a network adapter used to
connect PCs to TV cables in neighborhoods where
cable TV companies offer Internet services over TV
cables. The term broadband is used to refer to this
type of connection that carries multiple channels of
information over a single cable.

■ DSL stands for Digital Subscriber Line, a broadband
method of connecting to the Internet over existing
telephone lines. Synchronous DSL (SDSL) supports
the same high-speed data rate for both upstream
and downstream traffic. Asynchronous DSL (ADSL)
lowers the cost of DSL connections by using a high-
speed data rate for downloads but a slower rate for
uploads. Download speeds range from 384 Kbps to
8 Mbps, and upload speeds range from 128 Kbps to
1 Mbps. The faster the speed, the higher the cost.

■ An Internet connection that is always on is called a
direct connection. Ethernet, ISDN, cable modem,
DSL, and satellite all use direct connections.

Browsing the Web

■ On the Internet, surfing means to use a program
called a browser to go from site to site in search
of information that interests you.

■ A link is a hot spot that, when clicked, triggers
the object of the link.

■ Progressively clicking through the Web by
triggering the links that interest you is known as
browsing, a term synonymous with surfing the
Net. The program you use when you surf the
Web is called a browser.

■ Microsoft makes the most popular Web browser,
which is called Internet Explorer (IE). Other
browsers include Netscape Navigator and Safari,
the default browser that ships with every new
Macintosh.
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■ The open source version of Netscape Navigator is
called Mozilla.

■ Old versions of Web browsers are called legacy
browsers; in computing, the term legacy refers to
something old.

■ Every place you can go on the Web has an address
known as a URL, which stands for Uniform
Resource Locator.

■ The first part of a URL is called the protocol.
The Web’s protocol is HTTP, which stands for
hypertext transfer protocol. Other protocols
include FTP, mailto, news, telnet, and Gopher.

■ On the Web, the page you define as your take-off
point or start page is called your home page.
Almost every company has a home page, as do
government offices, schools, and colleges.

■ If you go to a Web site without requesting a
specific document, you view that site’s default
page, which is often the home page of the
company or person who owns the site.

■ If you request a specific document that cannot be
found, you get the error 404: file not found. If
you strip the filename off of the URL and browse
to the part of the site that formerly contained the
document, you can sometimes find what you are
looking for or get a clue as to what happened to
the missing file.

■ In a Web browser, a bookmark is a pointer to a
Web page that enables you to jump directly to
that page, without having to navigate the Web to
get there. In the Internet Explorer, bookmarks are
called favorites.

■ When you surf the Web, your browser keeps
copies of the most recently visited Web sites in a
place on your hard disk called the cache. You can
purge (i.e., delete) the cache if you have been
reading sensitive information that you would not
want someone else using your computer to find.

■ The Wireless Application Protocol (WAP) was
invented to provide mobile telephone users with a
way of accessing the Internet by routing requests
through a WAP server that translates Web pages
into a format appropriate for display on mobile
phones. The pages are formatted according to the
rules of the Wireless Markup Language (WML).

Handling Multimedia Objects, Plug-ins, and
Viewers

■ Helpers are applications known as helper apps that
the browser launches to handle certain kinds of
multimedia files. In the Windows operating system,
you can change the helper apps by redefining the
filename associations in the Windows File Manager.

■ Plug-ins are software modules that enable computer
applications, such as browsers, to play media
objects directly instead of launching a helper app to
handle the file externally. Macromedia Flash is the
most popular multimedia plug-in on the Internet.

■ Java is an object-oriented programming language
invented by Sun Microsystems. Java can be used to
create little applications, called applets, that can be
transmitted over the Internet as part of a Web page.

■ JavaScript is a client-side object-based scripting
language that enables you to create dynamic Web
pages without having to become a full-fledged
Java programmer.

■ An Active Aerver Page (ASP) is a Web page that
can execute on the server scripts written in either
VBScript or JScript, which is very similar to
JavaScript.

■ C# and J# are newly invented server-side
programming languages that are part of the
Microsoft .NET Framework, which also contains
.NET versions of JScript and VBScript.

■ Invented by Microsoft, ActiveX is a plug-in
technology that enables a wide variety of
Windows controls to be embedded in HTML
documents. The ActiveX Flash control, for
example, enables Flash objects to be downloaded
and executed as part of a Web page at runtime.

Configuring Browser Security

■ On the Internet, a zone is a predefined range or
selection of Web sites or addresses. The IE browser
lets you configure different security settings in four
different zones called (1) Internet, (2) Local
intranet, (3) Trusted sites, and (4) Restricted sites.

■ Into the Restricted sites zone, you place Web sites
that you believe could damage your computer or
data. You put sites you trust into the Trusted sites
zone. The Local intranet zone contains Web sites
on your organization’s intranet. By definition, all
other sites are in the Internet zone.
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■ Windows users should periodically pull down the
IE Tools menu and run Windows Update to
download and install the latest security patches
that help safeguard against being attacked by
viruses, worms, and Trojans. Setting Windows
Update to run automatically is the best way to
make sure you always have the latest updates.

■ A virus is malicious or unwanted code that installs
itself on your computer without your knowledge
by hiding inside other programmed objects. A worm
is a special kind of virus that can replicate itself
without hiding inside other objects. A Trojan (also
called a Trojan horse) is a malicious application that
masquerades as a desired object that you download
knowingly to your computer.

Finding Things with Search Engines

■ Yahoo! is the Web’s most famous subject-oriented
search directory. Like most of the Internet’s search
engines, Yahoo! also now contains full-text
keyword searching.

■ AltaVista was one of the Web’s first and finest
full-text search engines. It is now being challenged
by Google, which features full-text as well as
subject-oriented searching.

■ Most search engines support the advanced search
syntax, which lets you use quote signs, parentheses,
and the Boolean operators AND, OR, and NOT to
refine a search that may not be finding what you
are looking for.

■ Metasearching is the searching of searching,
which you perform with a metasearch engine that
invokes the other search engines automatically,
synthesizes the results, and reports back with a
single integrated list of hits. MetaCrawler,
Dogpile, and Search.com are the most popular
metasearch engines.

■ Scholarly search engines restrict a search to
reputable sources of information that are more
trusted and reliable than the public Internet.
Examples of scholarly search engines are ERIC,
About.com, Britannica.com, and XanEdu.

■ Multimedia searches enable you to find pictures,
audio, animations, and videos. Lycos, AltaVista,
and Singingfish were the pioneers in multimedia
searching.

■ Newsgroups are searchable at several search sites,
including AltaVista, Dogpile, Excite, Google,
InfoSeek, and Yahoo! If you write messages
in newsgroups, you need to realize that your
messages are keyword searchable unless you set
the x-no-archive flag when you write the message.

■ Archie is a legacy tool that can search the
filenames of the millions of files that are available
on anonymous FTP sites.

■ Gopher is another legacy protocol for organizing
files in hierarchical menus on the Internet. Some
related tools are Veronica, a search tool for finding
Gopher files, and Jughead, a program that added
keyword search and Boolean operator capabilities
to Gopher search. Gopher, Veronica, and Jughead
are legacy tools that do not have much practical
use on the Internet today. In the early 1990s,
however, Gopher was the killer application of
the Internet.

■ Good search engines for finding people are
Bigfoot, WhoWhere, Switchboard, and Yahoo!’s
people search.

■ The best place to find places is MapQuest, which
serves an average of more than 10 million maps
per day.

■ The best places to find legal information are
Law.com, FindLaw.com, and LexisONE.com.
These are the sites where lawyers go to get
breaking legal news and conduct legal searches.

■ Search engines are undergoing a lot of research
and development on the Internet. A good place
to keep up with what is happening is
searchenginewatch.internet.com.

Downloading from the Internet

■ The quickest way to download text from the
Internet is to copy the text onto your computer’s
Clipboard, from which you can paste the text into
any other window on your screen. You can also
open a text file with your browser, pull down the
File menu, and use the Save option to save the file
on your computer.

■ The Adobe Acrobat Reader is a free plug-in that
reads files in the Portable Document Format
(PDF), which Adobe created as a platform-
independent mechanism for sharing documents
across the Internet.
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■ To download an image from the Internet, use your
browser to display it. Then right-click (Windows)
or CONTROL-click (Macintosh) the image to pop
out the quick menu, and choose the option to save
the image or picture to your hard drive.

■ On the Web, there are only two file formats that
every Web browser can be guaranteed to support:
GIF and JPEG. The World Wide Web Consortium,
however, has created a Portable Network Graphics
(PNG) format intended to replace the patented GIF
format.

■ To download audio and video, you right-click
(Windows) or CONTROL-click (Macintosh) the
link that triggers the audio or video, and use the
quick menu to save a copy on your hard drive.

■ MPEG is emerging as the digital video standard for
the United States and most of the world. MPEG
stands for Motion Picture Experts Group, the
International Standards Organization committee
that created it.

■ An archive is a container into which one or more
files have been compressed to save space and
packed into a single file that can be transmitted

easily over a network. When you receive such
a file, you need to use an extractor to unpack
the archive and restore its contents onto your
computer. Windows users normally unpack
archived files with a product known as PKZIP for
Windows. Macintosh users unpack archived files
with Stuffit Expander, which is also available in a
Windows version.

■ A self-extracting archive is an executable file
which, when executed, automatically extracts the
files that are contained in the archive.

■ Whenever you save a downloaded file on
your computer, make sure the file you save has
the correct filename extension for the type of
file it is.

■ Whenever you download files from the Internet,
you should run a virus scan on your computer
to make sure you have not received a virus. You
can make virus-scanning happen automatically
if you set your antivirus software to scan
all incoming and outgoing mail and file
transfers.
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■ Key Terms Quiz
1. A networking company that connects you to the

Internet is called a(n) ____________________.

2. The invention of ____________________ in Bob
Metcalfe’s Harvard Ph.D. thesis in 1973 was a
data communications breakthrough that fueled
the explosion of local area networks.

3. DSL stands for ____________________.

4. The term ____________________ refers to the
type of connection that carries multiple channels
of information over a single cable.

5. When you surf the Web, your browser keeps
copies of the most recently visited Web sites in a
place on your hard disk called the ___________.

6. A(n) ____________________ is a real-time feed
from an audio or video source, encoded in such
a way that the media can begin playing steadily

without making the user wait for the entire file
to download to their computer.

7. A(n) ____________________ is a software
module that adds functionality when installed
into an existing computer application.

8. Distributed by Macromedia, ________________
is a very popular multimedia plug-in that is
installed on more than 97 percent of the
Internet’s end-user computers.

9. In computing, a(n) ____________________ is a
software entity that is programmed to perform
certain tasks or behave in certain ways
depending on the context in which it is used.

10. AND, OR, and NOT are ___________________
operators used in constructing a search with
advanced search syntax.

■ Multiple-Choice Quiz
1. Which of the following things do you need to

get connected to the Internet?
a. Internet-ready computer
b. Operating system
c. TCP/IP
d. Client software
e. Internet connection
f. Internet address
g. All of the above

2. Which of the following ways of connecting to
the Internet theoretically has the most
bandwidth?
a. Dialup modem
b. ISDN Basic Rate Interface
c. Cable modem
d. Tin cans and a string

3. What kind of link triggers when you mouse
over a hot word and click to follow the link?
a. Hypergraphic
b. Image map



c. Inline
d. Hypertext

4. The simultaneous broadcast of a live event over
the Web is called a
a. Cablecast
b. Intercast
c. Webcast
d. Newscast

5. Microsoft’s plug-in technology is called
a. Flash
b. Java
c. ASP
d. ActiveX

6. Java applications that can be transmitted over
the Internet as part of a Web page are called
a. Beans
b. Modules
c. Applets
d. Servlets

7. A malicious application that masquerades as a
desired object that you download knowingly to
your computer is called a
a. Virus
b. Worm

c. Trojan
d. Patch

8. Into which zone do you place Web sites that you
believe could cause damage to your computer or
your data?
a. Internet
b. Local intranet
c. Trusted sites
d. Restricted sites

9. Which of the following is a metasearch engine?
a. Yahoo!
b. Google
c. Dogpile
d. ERIC

10. Which audio file format records a stream of
performance information that tells your
computer’s sound chip when to turn notes on
and off, how loud to make them, and what
instrument should make the sound?
a. AIFF
b. MP3
c. RAM
d. MIDI
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■ Essay Quiz
1. Follow this book’s Web site link to the DSL lookup site, and find out whether DSL is available in your

neighborhood. If DSL is available, what data rates are available in your neighborhood, and what do
they cost?

2. Contact your cable TV company to find out if cable modems are available. If so, how much does it cost to
get connected, and what is the ongoing cost? If your cable TV company tells you cable modem service is
not available, follow this book’s Web site link to the Cable Modem Area Code Search to find out if any
other companies offer cable modems in your area.

3. Survey ten or more of the homes in your neighborhood to find out how they are connected to the Internet.
List the kinds of connections you find (such as dialup modems, ISDN, cable modems, or DSL) and tell
what percentage of your neighbors use each type of connection. If any of your neighbors are not
connected, include on your list the percentage of homes you surveyed that are not on the Internet.

4. Flash can make your Web browser do some really neat stuff. Follow this book’s Web site links to the Flash
showcase. View some of the demonstrations you find there. Make a list of the features you find Flash
supporting that you have not seen on Web pages that don’t use Flash. What is your favorite Flash feature?

Note: If you do not have the latest version of Flash, you will be prompted to install it. Go ahead and do so.

5. At this book’s Web site, follow the links to the people-finder search engines listed in the section on how
to find people. Look yourself up in the different directories. Does Bigfoot find you? How about WhoWhere?
Do you find yourself listed in Switchboard and Yahoo! People Search? How do you feel about being
included or excluded from these people finders? If you are not included and you would like to be,
follow the onscreen instructions for getting yourself listed.
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Lab Projects

• Lab Project 2-1: Connectivity Planning
For the employees of a company or school to work online, they need to be able to connect to the Internet.
Imagine that you work for a small company or school that has decided to begin permitting its employees to
do some of their work from home. Your employer has asked you to recommend the best method or strategy
for your fellow employees to connect from home so they can telecommute over the Internet. In developing
this recommendation, you will need to consider the following factors:

■ Time How many hours per week will the typical employee spend telecommuting?

■ Bandwidth Does your school or company require high bandwidth for some or all of its computing activities?

■ Geography Do the employees live within a local calling distance, or are they spread out over a broader space?

■ Cost In almost every school or company, you need to stay within a budget. Refer to the cost comparison in
Table 2-1, and consider the cost of the telecommunication solutions you recommend.

Use a word processor to write up your telecommuting recommendation in the form of a brief essay describing
the network strategy that seems appropriate for your coworkers to connect to the Internet from home. If your
instructor has asked you to hand in the recommendation, make sure you put your name at the top and then
save it on disk or follow any other instructions you may have been given for this assignment.

• Lab Project 2-2: Sharing Bookmarks and Favorites
One of the most valuable resources a school or company can have is a list of good, reliable, recommended Web sites
where employees can go to accomplish the kinds of tasks typical of the workplace. In this chapter, you learned that
the Internet Explorer contains a Favorites mechanism for accessing such sites quickly.

Imagine that your employer has asked you to create a common list of bookmarked favorites that your fellow
employees can use to enhance productivity in your workplace. Follow these steps:

1. Use the IE Web browser to visit the sites you want included in the list of bookmarked favorites.

2. While you are at each site, follow the steps you learned in this chapter to bookmark it.

3. Your list should contain at least seven bookmarks. If you need help finding seven appropriate sites,
use the search engines you learned in this chapter.

4. Pull down the File menu and choose Import and Export; the Import/Export wizard appears.

5. Click Next to begin the wizard, and follow the onscreen instructions.

6. When the wizard asks what you want to import or export, choose Export Favorites.

7. When the wizard asks what folder or subfolder of the favorites you want to export from, click what you
want and click Next.

8. When the Wizard asks where you want to save the exported folder, click the Browse button to choose the
folder of your choice. Your bookmark.htm file will be copied into the folder you designate. Click Next.

If your instructor has asked you to hand in the exported bookmark file, the file to submit will be named
bookmark.htm. Copy that file to a disk, or follow the other instructions your instructor gave you for submitting
this assignment. If you have trouble finding the bookmark file, click the Windows Start button and use the Search
option to locate the file. Later in this book, after you learn how to publish files on the Web, you will be able to
publish this bookmark file to a location from which your users can easily access it over the Web or import it into
their browser’s bookmarks or favorites.


